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Overview

Overview
This guide provides instructions on how to install and configure the Analysis Cubes and
Performance Dashboards components of the Deltek Vision 7.1 Performance Management
module. These instructions apply for both the Performance Management edition and the
Performance Management Analysis Cubes edition of the Performance Management module.
These instructions also apply for both new Vision 7.1 Performance Management installations and
upgrades from earlier versions.

Performance Management Editions
Performance Management is an optional module that comes in two editions:


Vision Performance Management Edition
This edition contains the Analysis Cubes, Performance Dashboards, and Visualization
components:


Analysis Cubes — This provides you with a Vision project data cube and a general
®
ledger data cube from which you create custom Vision reports with Microsoft Excel
or any business intelligence tool that supports SQL Server Analysis Services OLAP
cubes. The Analysis Cubes also serve as the data sources for the performance
dashboards that you create.



Performance Dashboards — Use Tableau® Server and Tableau Desktop (products
of Tableau Software®, Inc.), along with Vision Analysis Cubes and Microsoft SQL
Server Analysis Services components, to create role-based graphical performance
dashboards. Performance dashboards are business intelligence tools that executives
and managers use to view and interact with critical project and general ledger data
using a variety of graphical representations of that data. The performance
dashboards are displayed as dashparts on the Vision Dashboard.
Vision Performance Management provides a set of sample performance dashboards,
created using the Tableau software, that you can use as examples of the capabilities
of performance dashboards and as a starting point for building your own performance
dashboards. Each set is designed for a specific management and responsibility role
in your firm, from corporate executives to project managers.



Visualization — The Visualization feature in Vision Performance Management is a
visual data analysis tool with interactive graphics. Visualization enables you to
display key metric values for your projects, project plans, and opportunities in a
graphical format to help you analyze performance, determine trends, and identify
risks to your business. You can bring together metrics with different scales and time
periods, and you can quickly switch the focus from one metric to another.
Visualization is installed automatically as part of the Vision installation process. It
does not have a separate installation procedure.



Performance Management Analysis Cubes Edition
This edition contains only the Analysis Cubes component:
Analysis Cubes — This provides you with a Vision project data cube and a general
®
ledger data cube from which you create custom Vision reports with Microsoft Excel or
any business intelligence tool that supports SQL Server Analysis Services OLAP cubes.
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If You Have a 6.x Version of Analysis Cubes Installed
Analysis Cubes became part of the Performance Management module in the Vision 7.0 release.
If you have a 6.x version of Analysis Cubes installed:


To access the new features for Analysis Cubes in Vision 7.1, you must purchase 7.1
Performance Management or Performance Management Analysis Cubes.



If you install Vision 7.1 but you do not purchase 7.1 Performance Management or
Performance Management Analysis Cubes, you still have access to the same
functionality and features that you had in your 6.x Analysis Cubes deployment.
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Adding Custom Notes to This Guide

Adding Custom Notes to This Guide
®

If you would like to add custom notes to this guide that are specific to your company, Adobe
®
Reader X provides this ability. If you do not already use Adobe Reader X, you can download it
here free from Adobe.
To add a custom note using Adobe Reader X, complete the following steps:
1. On the Reader toolbar, click Comment at the far right.
2. In the Annotations pane that displays, click
match the button.

Sticky Note. The cursor changes to

3. Position the cursor at the location in the guide where you want the note to appear, and
click. A note icon is inserted at the location and a text box pops up.
4. Enter your information in the text box.
5. Continue adding notes as needed.
6. Save the document.
Deltek recommends that you save the document to a slightly different file name to keep the
original file from being overwritten.

When reading the document, cursor over a note icon to see the information. Double-click a note
icon to edit the information.

Installation and Configuration Guide for Performance
Management

3

If You Need Assistance

If You Need Assistance
If you need assistance installing, implementing, or using Vision, Deltek makes a wealth of
information and expertise readily available to you.

Customer Services
For over 20 years, Deltek has maintained close relationships with client firms, helping with their
problems, listening to their needs, and getting to know their individual business environments. A
full range of customer services has grown out of this close contact, including the following:


Extensive self-support options through the Customer Care Connect Web portal.



Phone and email support from Customer Care analysts



Technical services



Consulting services



Custom programming



Classroom, on-site, and Web-based training
Find out more about these and other services from the Customer Care Connect site.

Customer Care Connect Site
The Deltek Customer Care Connect site is a support Web portal for Deltek customers who
purchase an Ongoing Support Plan (OSP).
The following are some of the many options you have at the Customer Care Connect site:


Download the latest versions of your Deltek products



Search Deltek’s knowledge base



Ask questions, exchange ideas, and share knowledge with other Deltek customers
through the Deltek Connect Customer Forums



Display or download product information, such as release notes, user guides, technical
information, and white papers



Submit a support case and check on its progress



Transfer requested files to a Customer Care analyst



Use Quick Chat to submit a question to a Customer Care analyst online



Subscribe to Deltek communications about your Deltek products and services



Receive alerts of new Deltek releases and hot fixes
If you need assistance using the Customer Care Connect site, the online help available on the
site provides answers for most questions.
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Access Customer Care Connect
To access the Customer Care Connect site, complete the following steps:
1. Go to http://support.deltek.com.
2. Enter your Customer Care Connect Username and Password.
3. Click Log In.
If you do not have a username and password for the Customer Care Connect site, contact your
firm’s Vision Administrator.
If you forget your username or password, you can click the Account Assistance button on the
login screen for help.

Additional Documentation
The following table lists additional related Deltek documentation that is available for this release.
These documents are available for download from the Deltek Customer Care Connect site.
Document Name

Description

Deltek Vision 7.1 Release Notes

These release notes contain pre-installation information,
database changes, and a summary of enhancements and
software issues resolved in the Vision 7.1 release.

Deltek Vision 7.1 Performance
Management Content and
Functionality Overview

This guide provides an overview of Vision Performance
Management functionality and the pre-built visualizations
that are included with it.

Deltek Vision 7.1 Technical
Installation Guide

This guide contains detailed instructions for installing all
the technical components of Vision, including the servers,
the database, and the application itself.

Deltek Vision 7.1 Advanced
Technical Administration Guide

This guide provides IT staff and system administrators
with instructions for installing and configuring advanced
technical components of Vision.

Deltek Vision 7.1 Custom
Reports and Microsoft SQL
Server Reporting Services

This guide provides instructions to create, deliver, and
generate Vision custom reports with Microsoft SQL Server
Reporting Services and its report writing tools.

Deltek Vision 7.1 Microsoft SQL
Server Reporting Services
Licensing FAQ

This guide explains the Microsoft SQL Server Reporting
Services licensing implications for Vision.

Tableau® Server 8.0
Administrator Guide

This administrator guide, produced by Tableau Software®,
Inc., is a complete reference for handling administrative
tasks on Tableau Server. Use Tableau Server and
Tableau Desktop, along with Vision Analysis Cubes and
Microsoft SQL Server Analysis Services components, to
create role-based graphical performance dashboards.
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Chapter 1: Analysis Cubes Prerequisites and
Installation
Analysis Cubes Prerequisites
The following prerequisites must be met before you configure and use Vision 7.1 Analysis Cubes:


Microsoft SQL Server


You must have Microsoft SQL Server 2012, Microsoft SQL Server 2008, or Microsoft
SQL Server 2008 R2 installed.



The Standard or Enterprise edition of SQL Server must be installed. These editions
provide you with the required Analysis Services.



SQL Server 2005 is not supported.



For a full list of Microsoft SQL Server releases (R), service packs (SP), and
cumulative updates (CU) that Vision supports, see the Deltek Product Support
Compatibility Matrix. You can download this at the Deltek Customer Care Connect
site.
Service packs for Microsoft SQL Server 2008 R2 or Microsoft SQL Server 2008
that Vision supports must be installed after Analysis Services is installed. If you
already installed the service pack and you still need to install Analysis Services,
install Analysis Services, and then reinstall the service pack.



Microsoft SQL Server Analysis Services
You must have Microsoft SQL Server 2012, Microsoft SQL Server 2008, or Microsoft
SQL Server 2008 R2 Analysis Services (a component of SQL Server) installed.



Microsoft SQL Server Integration Services
You must have SQL Server Integration Services installed. This is a shared component of
the SQL Server 2012, 2008, and 2008 R2 installation.



Active Directory Domain Environment
You must have an Active Directory domain environment. Your Analysis Cubes clients and
database server must be members of the domain.



Vision Database Tier
The database tier of the Deltek Vision installation must be run on your database server.
This is necessary so you can install the Vision Resource Kit and configure the
environment for Analysis Cubes. If you are upgrading from Vision 6.x, you must upgrade
your existing installation on the database server. If you are currently running Vision 5.x,
you must uninstall Vision before you can install Vision 7.1 (upgrades are not supported
for Vision 5.x).
After the database tier installation, you must reboot your database server before you
configure the Analysis Cubes. This is necessary so that the environment variables that
are created during the installation are registered properly.
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Deltek provides OLAP (online analytical processing) services to assist you with the installation,
configuration, and optimization of your SQL Analysis Cubes. These services consist of
consulting, Web conferencing and training, installation guides, and reporting assistance. For
more information, please contact your Deltek account manager at
accountmanager@deltek.com.

Microsoft Excel® 2007 and Microsoft Excel 2010 are supported for Analysis Cubes.

Microsoft SQL Server Edition Dependencies
Some of the Vision Analysis Cubes functionality, new in Vision 7.0 and later versions, works only
if you have Microsoft SQL Server Enterprise Edition installed. If you do not have the Enterprise
edition installed and, instead, are using the Standard edition, the following items are not included
in the Analysis Cubes and Vision because the Standard Edition does not support semi-additive
measures.

Dimensions and Measures
Dimensions and measures that are not included in the data cubes if you use SQL Server
Standard Edition:


Presentation Currency




Accounts Receivable Trending






All the dimensions in the Presentation Currency dimension group in the Project and
General Ledger data cubes.

All the measures in the AR Trending measure group (including the measures in the
Multicurrency subfolder) in the Project data cube.

Days Sales Outstanding (DSO)


The DSO 90 and DSO 360 measures in the Accounts Receivable measure group in the
Project data cube.



The DSO 90 in Billing Currency and DSO 360 in Billing Currency measures in the
Multicurrency folder in the Accounts Receivable group.



The DSO 90 in Project Currency and DSO 360 in Project Currency measures in the
Multicurrency folder in the Accounts Receivable group.

Days Work-In-Progress Outstanding (DWO)


The DWO 90 and DWO 360 measures in the Unbilled folder in the Values group in the
Project data cube.



The DWO 90 in Billing Currency and DWO 360 in Billing Currency measures in the
Unbilled – Multicurrency folder in the Values group in the Project data cube.



The DWO 90 in Project Currency and DWO 360 in Project Currency measures in the
Unbilled – Multicurrency folder in the Values group in the Project data cube.
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Currency Exchange
The Currency Exchange tab in Vision Configuration » General » Analysis Cubes does not
display if you use SQL Server Standard Edition.

Key Performance Indicators (KPIs)
The following Deltek-provided KPIs are not available if you use SQL Server Standard Edition:


DSOTargetPrincipal



DSOTargetOrg1



DSOTargetProject Manager



DSOTargetNoDimension



DWOTargetPrincipal



DWOTargetOrg1



DWOTargetProject Manager



DWOTargetNoDimension

Microsoft SQL Server ─ Important Information
The following information applies for Microsoft SQL Server Standard or Enterprise editions for the
core database and Analysis Services requirements of Vision.

Multi-Dimensional Mode for Analysis Services
Deltek Vision Analysis Cubes supports only the installation of the standard multi-dimensional
mode for Analysis Services. It does not support the new tabular mode introduced with SQL
Server 2012.

Service Accounts and Permissions
When you installed Microsoft SQL Server, if you used the default service accounts that were
provided, the local service accounts for all SQL Server services that were configured
automatically do not have the necessary rights to perform some of the required steps to build
Vision Analysis Cubes. The following sections describe the service accounts that you need to
reconfigure to be able to build Vision Analysis Cubes.
SQL Server Analysis Services Service Account
The SQL Analysis Services service account must have db_owner rights to the Vision data
warehouse database. If it does not have these rights, the SQL Agent refresh job that you perform
in Step 5: Populate DW and Vision Cubes in the Resource Kit will fail after it runs for a long
period of time. For instructions on how to fix this, see the “Reconfigure the SQL Server Analysis
Services Service Account” section of this guide on page 23.
SQL Server Agent Service Account
When you installed Microsoft SQL Server, if you used the default service accounts that were
provided, the SQL Server Agent Refresh Job account does not have the necessary rights to the
file system on the server, so the Vision Analysis Cubes detailed output log will not be created.
For more information about how to fix this, see the “Enable the Detailed Output Log” section on
page 49.
Installation and Configuration Guide for Performance
Management
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Error Running SQL Agent Refresh Job on SQL 2012
The SQL Agent refresh job will fail when both of the following apply:


You installed SQL Server 2012 on a server as a second SQL instance.



The other instance of SQL was installed first and is an earlier version of SQL Server (for
example, SQL Server 2008 or 2008 R2).

The SQL Agent job will fail because the dtexec.exe process that runs the job is being called from
the previous SQL version instance because the SQL 2012 path to dtexec is listed second in the
PATH variable.
To prevent this issue, do either of the following:


Modify the SQL Agent refresh job to include the fully qualified path to the SQL 2012
version of dtexec.
Fully qualified path dtexec for SQL 2012:
C:\Program Files\Microsoft SQL Server\110\DTS\Binn



Change the path variable in the SQL Agent refresh job so that the SQL 2012 path is
listed first.
Example:
"C:\Program Files\Microsoft SQL Server\110\DTS\Binn\dtexec.exe" /F "C:\Program Files
(x86)\Deltek\Vision\Analysis\ETL_2K8\Jobs\EUAEuropa12_Cubes_enUS\Vision_ETL_Master_Package.dtsx" /Conf "C:\Program Files
(x86)\Deltek\Vision\Analysis\ETL_2K8\Jobs\EUAEuropa12_Cubes_enUS\VisionETL_Config.dtsconfig"

Install Vision Analysis Cubes and the Resource Kit
When you run the installation routine on your database server to install or upgrade your Vision
software, the Vision Analysis Cubes components and the Resource Kit (required to configure
Analysis Cubes) are installed and updated automatically. After these are installed, a system
administrator uses the Deltek Vision Resource Kit, Vision, and Microsoft SQL Server
Management Studio to configure Analysis Cubes.
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Chapter 2: Configure Analysis Cubes
You must complete the steps in this chapter to configure your database server before you can
use Vision Analysis Cubes to create custom reports.
These configuration instructions apply to:


New Vision 7.1 Analysis Cubes deployments



Upgrades from earlier versions of Vision


Upgrades from Vision 7.0 or 7.0 SP1 Analysis Cubes to 7.1



Upgrades from Vision 6.x Analysis Cubes to Vision 7.1, regardless of whether or not
you purchase the Performance Management module

Upgrade Vision Analysis Cube from Earlier Versions
Rebuiding the Analysis Cubes Data Cubes
If you currently have Vision Analysis Cubes configured and deployed, you must rebuild the
Analysis Cubes data cubes in their entirety when you upgrade to another Vision version release,
service pack (SP), or applicable cumulative update. The data cubes cannot be upgraded directly.
To rebuild, you must first delete the existing data warehouse (DW), SQL Server agent job, and
Analysis Services database. Then you complete the configuration steps as you did when you
originally configured Analysis Cubes.
The following is a summary of the steps that you must perform to rebuild the Analysis Cubes data
cubes after you upgrade Vision to a new release, including cumulative updates (previously called
“hot fixes”).
If you are upgrading from Vision 6.x, you must complete the Analysis Cubes configuration steps
whether or not you purchase the Vision 7.1 Performance Management module.



To access the features for Analysis Cubes in Vision 7.1, you must purchase the 7.1
Performance Management module.



If you install Vision 7.1 but you do not purchase the 7.1 Performance Management
module, you still have access to the same functionality and features that you had in
your 6.x Analysis Cubes deployment. To be able to access Analysis Cubes, you must
complete all the Analysis Cubes configuration steps in this chapter.

To upgrade to Vision 7.1 if you currently have Analysis Cubes 6.x, 7.0, or 7.0 SP1 deployed
or to rebuild Analysis Cubes after you install a cumulative update that requires you to
rebuild Analysis Cubes, complete the following steps:
1. Run the Vision 7.1 database tier installation on your database server to upgrade the
database tier components to Vision 7.1.
If you currently have Vision 5.x installed, you must uninstall the Vision software on all
tiers before you install Vision 7.1.

2. Delete the existing data warehouse (DW), SQL Server agent job, and Analysis Services
database. "Delete Your Existing Data Warehouse and Data Cubes" on page 14 of this
guide provides instructions for this.
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3. Complete all the Analysis Cubes configure steps in the Vision Resource Kit and in
Microsoft SQL Server Management Studio outlined in this chapter (as you originally did
when you first configured the earlier version of Analysis Cubes).

Custom Reports Created in Earlier Vision Versions
The following information applies if you created custom reports with Vision Analysis Cubes 5.x or
6.x and you are upgrading to Vision 7.1. This applies whether or not you purchase and install the
Vision 7.1 Performance Management module.
Renamed Vision Fields
If you have custom reports in which a Vision field name has been renamed in the Vision 7.0
databases, the renamed field is automatically removed from your report. You must re-add the
new field name to the report. (No fields were renamed in Vision 7.0 SP1 or Vision 7.1.)
The "Database Changes" section of the Vision 7.0 release notes provides a list of renamed
fields in the "Renamed Columns" subsection.

Deleted Vision Fields
Vision fields that have been deleted from the Vision database in Vision 7.0 or 7.1 that were
included in the 5.x or 6.x database are automatically removed from your reports. (No fields were
deleted in Vision 7.0 SP1.)
The "Database Changes" section of the Vision 7.0 release notes and the Vision 7.1 release
notes provide a list of renamed and deleted fields in the "Removed Columns" and "Removed
Tables" subsections.

Fields that Have Been Moved in the Excel PivotTable Field List
A small number of dimension and measure fields were moved to different folders in the Excel
PivotTable Field List in Vision 7.0. If a dimension or measure was moved, it was also removed
from your existing custom reports. You must re-add it to your reports.

Summary List of Analysis Cubes Configuration Steps
The following table lists the steps that are required to configure your database server for Vision
Analysis Cubes for new installations. For upgrade installations, start with Step 1. For new
installations, start with Step 2.
The specific instructions for each of the Analysis Cubes configuration steps are included in the
remaining sections of this chapter.
Step
1

Where to Perform

Description

Microsoft SQL Server
Management Studio

This step applies only if you currently use Analysis Cubes 6.x or
7.0, or 7.0 SP1, and you are upgrading to 7.1.
Delete your existing 6.x or 7.0 data warehouse (DW), SQL
Server agent job, and Analysis Services database.
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Step

Where to Perform

Description

2

Vision:
Configuration »
Module Activation

If you purchased the Performance Management module,
activate the module.

3

Vision Resource Kit
on the Vision
database server

Check that all prerequisites are installed.
In the Resource Kit, this is Step 1: Check Prerequisites.

The Analysis Cubes Prerequisites section of this guide identifies
the prerequisites.
4

5

Vision Resource Kit
on the Vision
database server

Create the Vision data warehouse and the Vision data cubes
that are stored in the data warehouse.

Microsoft SQL Server
Configuration
Manager on the
Vision database
server

Ensure that the SQL Analysis Services Service account has
rights to the Vision DW database.

In the Resource Kit, this is Step 2: Setup.

You may need to reconfigure the SQL Analysis Services service
account to a domain account in order to grant the necessary
rights.
See the “Reconfigure the SQL Server Analysis Services Service
Account” section.

6

Vision Resource Kit
on the Vision
database server

Apply system labels to the data cubes.
In the Resource Kit, this is Step 3: Apply System Labels to the
Cubes.

Do not run Step 4: Apply Cube Configurations after you
complete Step 3: Apply System Labels to Cubes.

7

Vision Resource Kit
on the Vision
database server

Populate the data warehouse and data cubes. Create the SQL
Server Agent job to refresh the cubes.
In the Resource Kit, this is Step 5: Populate DW and Vision
Cubes.
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Step

Where to Perform

Description

8

Vision:
Configuration »
General » Analysis
Cubes

This step applies only if you purchased and activated the Vision
Performance Management module.
If you are performing an upgrade installation from Vision 7.0 or
7.0 SP1, you can skip this step since you already completed
this.
In the Vision main software, complete Analysis Cubes
Configuration as needed: Select the dimensions and measures
to populate the data cubes; create key performance indicators
(KPIs); create calculated measures; and set up currency
exchange information.
See the Vision online Help for specific instructions.

9

Vision:
Configuration »
General » Userdefined
Components »
Fields tab

This step applies only if you purchased and activated the Vision
Performance Management module.
If you are performing an upgrade installation from Vision 7.0 or
7.0 SP1, you can skip this step since you already completed
this.
In the Vision main software, select user-defined fields to
populate the data cubes.
See the Vision online Help for more information and specific
instructions.

10

Vision Resource Kit
on the Vision
database server

This step applies only if you purchased the Vision Performance
Management module.
Apply the Analysis Cube settings that you entered in Vision
Configuration (steps 6 and 7 in the summary list) to the data
cubes.
In the Resource Kit, this is Step 4: Apply Cubes Configurations.

11

12

Vision Resource Kit
on the Vision
database server

Populate the data warehouse and data cubes. Create the SQL
Server Agent job to refresh the cubes.

Microsoft SQL Server
Management Studio

Validate that the Analysis Cubes configuration completed
successfully.

In the Resource Kit, this is Step 5: Populate DW and Vision
Cubes.
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Step
13

Where to Perform

Description

Microsoft SQL Server
Management Studio

Create an Analysis Services role for Vision Analysis Cube
users.
After you complete this step, users can access the Vision data
cubes through your corporate network (LAN or WAN). Custom
Vision reports can now be created.

14

Microsoft SQL Server
Management Studio

Script the Analysis Services role creation for future use.

15

Vision Web server or
another server with a
supported installation
of IIS (Internet
Information Services)

Optional: Configure Analysis Cubes for Internet Accessibility.
See "Chapter 5: Configure Analysis Cubes for Internet
Accessibility" on page 54 for instructions.

16

Vision Resource Kit
on the Vision
database server

If you have multiple Vision databases, you must set up data
cubes for each database.

and

Repeat steps 1–1 of this summary list to create additional data
cubes.

Microsoft SQL Server
Management Studio
17

Vision Resource Kit
on the Vision
database server

Ongoing Maintenance: After you initially configure Analysis
Cubes, any time you modify system labels or Analysis Cubes
configuration settings in Vision, use the Resource Kit to apply
the changes to the data cubes.

SQL Server Clustered Environments
If you operate in a SQL Server clustered environment, you must follow the instructions in the
"Appendix A: Configure Vision Analysis Cubes for a SQL Server Clustered Environment" section
on page 103 of this guide in place of steps 1–6, 9–10, and 15–16 in the preceding summary list.
You cannot use the Resource Kit if you have a SQL Server clustered environment.

Delete Your Existing Data Warehouse and Data Cubes
If you are configuring Analysis Cubes for the first time, skip this step, and continue with the next
section of this chapter.
The steps in this section apply only if one of the following applies:


You currently have Analysis Cubes configured, and you are upgrading from Vision 5.x,
6.x, 7.0, or 7.0 SP1 to Vision 7.1. Complete these steps to delete your existing Analysis
Cubes components before you deploy Vision 7.1 Analysis Cubes.
The Resource Kit for 7.0 and above has been coded to automatically detect Vision 7.0 and
above cube deployments and will prompt you to overwrite the components when you re-run Step
#2.
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The steps in this section explain how to use SQL Server Management Studio to delete the
following:


Data warehouse database



SQL Server Agent job, which refreshes the data



Analysis Services database

Use default naming conventions for the data warehouse, SQL Agent job, and analysis databases.
Vision 5.x and 6.x deployments supported custom naming, so the names you used may differ
from the examples listed below:


Data warehouse database name — <Vision database>DW. For example,
"VisionDemo61DW" in the example below.



SQL Server Agent Job — Refresh <Vision database> DW and Cubes. For example,
"Refresh VisionDemo61 DW and Cubes" in the example below.



Analysis Services database — Deltek Vision Analysis

To delete the Analysis Cubes data warehouse database, the SQL Agent job, and the
Analysis Services database, complete the following steps:
1. Connect to the Database Engine using SQL Server Management Studio.
2. Expand the Databases folder.
3. Right-click the data warehouse database and click Delete.
4. Expand the SQL Server Agent folder, and then expand the Jobs folder.
5. Right-click the SQL Agent refresh job and click Delete.
6. Connect to Analysis Services using SQL Server Management Studio.
7. Expand the Databases folder.
8. Right-click the Analysis Services database and click Delete.
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Examples of what you need to delete:
SQL Server Management Studio

Vision 6.x data warehouse database to delete.

SQL Server Agent job to delete.

Analysis Services in SQL Server Management Studio:

Analysis Services database to delete.

Activate the Performance Management Module
If you purchased the Performance Management module, activate it now if it is not already
activated.
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Analysis Cubes became part of the Performance Management module as of Vision 7.0.
If you have a 6.x version of Analysis Cubes installed:



To access the features for Analysis Cubes in Vision 7.1, you must purchase the 7.1
Performance Management module.



If you install Vision 7.1 but you do not purchase the 7.1 Performance Management
module, you still have access to the same functionality and features that you had in
your 6.x Analysis Cubes deployment.

To activate the Performance Management module, complete the following steps:
1. From the Navigation menu in Vision, click Configuration » Module Activation.
2. On the Module Activation form, enter your password for the Performance Management
module, and click OK.
If you purchase and activate the Performance Management module after you complete the
remaining Analysis Cubes configuration steps, you must delete your existing data warehouse
(DW), SQL Server agent job, and Analysis Services database, and repeat all the configuration
steps to completely rebuild the data cubes.

Open the Vision Resource Kit
You will use the Vision Resource Kit to:


Check that you have all the prerequisites installed.



Create the Vision data warehouse and the data cubes that are stored in the data
warehouse.



Apply the Vision system labels to the data cubes.
If you operate Vision on more than one tier, you must run the Resource Kit from the database
tier.

Open the Vision Resource Kit
To open the Vision Resource Kit, complete the following steps:
1. From your Vision database server, click Start » All Programs » Deltek Vision » Deltek
Vision Resource Kit.
If user account control (UAC) is enabled on your Windows 2008 or R2 server (it is
enabled by default), right-click Deltek Vision Resource Kit and click Run as
administrator on the shortcut menu.
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2. On the Deltek Vision Resource Kit dialog box, click the Database tab, and on the
Database Server Logon dialog box, select the Windows Integrated check box.
You must connect using Windows Integrated. If you do not select Windows
Integrated, and, instead, you use SQL Authentication, you will be unable to deploy the
cubes. You will receive a message in the Resource Kit during Step 1: Check
Prerequisites that informs you that you must be logged on the Deltek Vision Resource
Kit Database tab using Windows Integrated Security.

3. On the Database Server Logon dialog box, the server name prefills in the Server field. If
you are running a non-default SQL Server instance, also enter the instance name in the
Server field (<server>\<instance>).
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Check Prerequisites
To check that the Analysis Cubes prerequisites are installed correctly, complete the
following steps:
1. On the Database tab of the Deltek Vision Resource Kit dialog box, click the Analysis
Services tab.

2. On the Analysis Services tab, click the Step 1: Check Prerequisites button to confirm
whether or not you have all the Analysis Cube prerequisite software installed.


If all prerequisites are installed, you receive a Vision BI Prerequisites are satisfied
message.



If prerequisites are not installed, you receive a message that identifies the missing
prerequisites. You must install or configure all missing prerequisites before you can
continue with the Analysis Cubes configuration steps.

Installation and Configuration Guide for Performance
Management

19

Chapter 2: Configure Analysis Cubes

Create the Vision Data Warehouse and Data Cubes
To create the Vision data warehouse and data cubes, complete the following steps:
1. In the Setup section of the Analysis Services tab on the Database tab in the Resource
Kit, complete the following actions:

a. Select your Vision database from the Vision Databases for BI drop-down list.
b. Select a language from the Language drop-down list.
Possible options, based on the languages that you purchased, are:


English (United States)



English (International)



French (Canada)



French (France)
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Spanish (International)



Dutch (Netherlands)



German (Germany)

The Data Warehouse Database field prefills with a name that is based on your
Vision database name and the language that you entered in the Language field. You
cannot modify the name. The naming convention for the data warehouse database
name for all languages other than English (United States) is:
<Your database name>DW_<language culture>.
In the examples in the table below, “Vision” is the name of the Vision database. DW
stands for data warehouse.
Language That You Entered
in the Language Field

Prefilled Data Warehouse
Database Name

English (United States)

VisionDW

English (International)

VisionDW_en-GB

French (Canada)

VisionDW_fr-CA

French (France)

VisionDW_fr-FR

Spanish (International)

VisionDW_es-ES

Dutch (Netherlands)

VisionDW_nl-NL

German (Germany)

VisionDW_de-DE

The Analysis Database Name field prefills with a name that is based on your Vision
database name and the language that you entered in the Language field. You
cannot modify the name. The naming convention for the analysis database name for
all languages other than English (United States is:
Deltek Vision Analysis - <Your Vision Database name>_<Your language culture>.
In the examples in the table below, “Vision” is the name of the Vision database.
Language That You Entered
in the Language Field

Prefilled Analysis Database Name

English (United States)

Deltek Vision Analysis - Vision

English (International)

Deltek Vision Analysis - Vision_en-GB

French (Canada)

Deltek Vision Analysis - Vision_fr-CA

French (France)

Deltek Vision Analysis - Vision_fr-FR

Spanish (International)

Deltek Vision Analysis - Vision_es-ES

Dutch (Netherlands)

Deltek Vision Analysis - Vision_nl-NL
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Language That You Entered
in the Language Field

Prefilled Analysis Database Name

German (Germany)

Deltek Vision Analysis - Vision_de-DE

2. Click the Step 2: Setup button in the Setup section of the Analysis Services tab to create
the data warehouse and Analysis Services database.


If you have not entered a module activation code in Vision for Vision Performance
Management, you receive the following message:

3. Click Yes to proceed with the configuration.
You must purchase and activate the Performance Management module to access
all of the Vision 7.1 and later Analysis Cube configuration features.
If you purchase and activate the Performance Management module after you
deploy and configure Analysis Cubes, you must delete your existing data
warehouse (DW), SQL Server agent job, and Analysis Services database, and
repeat all the configuration steps to completely rebuild the data cubes.

If you previously configured Analysis Cubes for Vision 7.1, a message informs you
that the current cube configuration will be overwritten, including the data warehouse,
the SQL Agent job, and the Analysis Services database.

4. Click OK to continue.
The existing data warehouse and Analysis databases will be deleted and recreated with
your current configuration settings. This step will not correctly delete your Vision 5.1, 6.x,
7.0, or 7.0 SP1 data cubes. You must do that manually as described in the "Delete Your
Existing Data Warehouse and Data Cubes" section on page 14 before you proceed with
this step.
The data warehouse and Analysis Services database are created now. During this
process, a dialog box identifies each component as it is created. When it completes, a
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Setup of Vision Data Warehouse and Cubes has been completed successfully
message displays at the bottom of the Vision Business Intelligence dialog box.

If you encounter any error messages in the Vision Business Intelligence dialog box,
review the DeltekVisionResourceKit.log file in the <Vision Installation Directory>\Logs
folder for details on the errors.

5. On the Vision Business Intelligence dialog box, click Close.

Reconfigure the SQL Server Analysis Services Service Account
When you install Microsoft SQL Server and you use the provided default service accounts, the
local service accounts for all SQL Server services are configured automatically. The SQL Server
Analysis Services account will run as “NT Service\MSSQLServerOLAPService.” Because this
account does not have the necessary rights to the Vision data warehouse database, the SQL
Agent refresh job that you will perform in Step 5: Populate DW and Vision Cubes in the
Resource Kit will fail after it runs for a long period of time.
The SQL Agent job executes Integration Services (.dtsx) packages that bring data into the data
warehouse database from the Vision transaction database. Then it populates the Analysis
Services database from the data warehouse. If the Analysis Services service account does not
have rights to the data warehouse, the second part of the refresh job will fail.
If you used the default service accounts when you installed SQL Server, you must reconfigure the
Analysis Services service account to run as a domain account that has db_owner rights to the
Vision data warehouse database (for example, <VisionDatabase>DW) before you deploy
Analysis Cubes.
In addition to the local service accounts created during the SQL Server installation, if you
assigned a service account for SQL Server Analysis Services that is not a member of the SQL
Server sysadmin role, the same issue will occur. The service account does not need sysadmin
rights, only db_owner rights to the Vision data warehouse.
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Reconfigure the Analysis Services service account to run as a domain
account
To reconfigure the Analysis Services service account to run as a domain account,
complete the following steps:
1. On the Vision database server, open the Microsoft SQL Server Configuration manager
from the Configuration Tools folder of the SQL Server program group.
2. In the left pane of the Sql Server Configuration Manager screen, click SQL Server
Services.
3. In the right pane of the Sql Server Configuration Manager screen, right-click the SQL
Server Analysis Services service for your instance, and on the shortcut menu click
Properties.
On the Log On tab of the SQL Server Analysis Services Properties dialog box, if the
service is running as a domain account, you can skip the remaining steps 5–7, and
continue with the steps in the next section to grant db_owner rights to the Vision data
warehouse database.

4. If the service is not running as a domain account, select the This account: option, and in
the Account Name field, enter a valid domain username in the form of
<Domain>\<Username>.
5. Enter and confirm the password for the domain account.
6. When you are prompted, restart the service.

Grant the domain account db_owner rights to the Vision data warehouse
database
To grant the domain account db_owner rights to the Vision data warehouse database,
complete the following steps:
1. Open and log in to SQL Server Management Studio.
Log in with an account that has sysadmin rights to the database engine.
2. In the left pane of the Microsoft SQL Server Management Studio screen, expand the
Security\Logins folder to see if the Analysis Services service account is listed as a login.
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If the account is listed as a login, continue with step 3.



If the account is not listed as a login: Right-click the logins, and select the option to
create a new login. Enter the <Domain>\Username> in the Login Name field. Select
the Windows Authentication option.

3. In the Select a page pane of the Login – New screen, click User Mapping.

4. In the Users mapped to this login: grid, select the check box in the Map column for the
<Vision>DW database.
5. In the Database role membership for: <Vision>DW section, select the db_owner
check box.
6. Click OK.
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Apply System Labels to the Data Cubes
This step applies labels that are entered on the Labels tab in Vision Configuration » General »
System Settings to the data cubes.
To apply system and custom labels to the data cubes, complete the following steps:
1. On the Analysis Services tab on the Database tab in the Resource Kit, click the Step 3:
Apply System Labels to Cubes button to apply your custom field labels to the data
warehouse.

2. On the message dialog box that informs you that you are about to make structural
changes to your Analysis Services database, click Yes.
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3. When you receive a message that the system labels have been successfully applied to
your Analysis database, click OK.

After you initially configure Analysis Cubes, any time you modify a Vision field label,
you must repeat Step 3: Apply System Labels to Cubes and Step 5: Populate DW
and Vision Cubes in the Resource Kit:

Do not perform Step 4: Apply Cubes Configurations in the Resource Kit after you
complete Step 3: Apply System Labels to Cubes in the Resource Kit. Continue on
with the next step--Populate the Data Warehouse (DW) and the Vision Data Cubes.
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Populate the Data Warehouse (DW) and the Vision Cubes
Deltek recommends that you complete this step after business hours when users are not
connected to the Vision transactional database.
If you receive a message during any of the following steps that indicates an error or failure, refer
to the "Chapter 3: Troubleshoot Analysis Cubes Deployments" section on page 48.

To populate the data warehouse and the data cubes, complete the following steps:
1. On the Analysis Services tab (on the Database tab in the Resource Kit), click the Step 5:
Populate DW and Vision Cubes button.

2. On the dialog box that recommends that you run this process during off hours, click Yes
to continue.

During this process, you see a status bar that displays the progress.
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3. When you receive the message that the Deltek Vision data warehouse and analysis
cubes have been populated, click OK.

If Step 5 fails, you receive the following message:

See the "Chapter 3: Troubleshoot Analysis Cubes Deployments" section on page 48 for
more information to help solve the problem.

Enter Analysis Cubes Configuration Settings in Vision
These steps apply only if you purchased and activated the Vision Performance Management
module.
Complete these steps in Vision after you complete the previously described steps in the
Resource Kit to check prerequisites, perform setup, apply system labels, and populate the data
warehouse and Vision cubes. If you complete these Configuration steps in Vision before you
complete the previous Resource Kit steps, KPI defaults will not be created in the data cubes.

Set Up Permissions for the IIS Application Pool Account
Before you enter and save Analysis Cubes Configuration settings in Vision, the identity of the IIS
Application Pool that runs the Vision application must have rights to the Analysis Services or
directly to the Vision data cube itself. If these rights have not been set up, you receive the
following message when you save settings in Configuration » General » Analysis Cubes:

Installation and Configuration Guide for Performance
Management

29

Chapter 2: Configure Analysis Cubes

To set up minimal rights, you can set up an Analysis Services role in SQL Server Management
Studio with the following rights entered on the General page of the Create Role dialog box:


Full control (Administrator)



Process database



Read definition

Then add the users who will be entering the Analysis Cubes Configuration in Vision to this
Analysis Services role on the Membership page of the Create a Role dialog box.
Only the account running the IIS Application pool needs to be a member of the role with Full
control (Administrator) rights. You will set up another role (described later in this document)
for your users, which only needs to have read-level access to the data cubes.

For more detailed instructions on creating a role, see the “Create an Analysis Services Role for
Your Domain Users” section on page 40.
Another way to give the IIS Application Pool rights to the Analysis Services is to add the IIS
Application Pool identity to the Analysis Server security configuration. To do this, you open SQL
Server Management Studio, and go to the Properties of the Analysis Server. Add the users who
will be entering Analysis Cubes Configuration in Vision to the Security page.

Enter Analysis Cubes Configuration Settings in Vision
Complete the following Analysis Cubes configuration in the main Vision software:
Path in Vision

Configuration Step

Configuration » General »
Analysis Cubes

Complete Analysis Cubes configuration as needed:


Select the dimensions and measures to populate
the data cubes.



Create key performance indicators (KPIs).



Create calculated measures.



Set up currency exchange information.

See the Vision online Help for more information.
Configuration » General » Userdefined Components » Fields tab

Select user-defined fields to populate the data cubes.
See the Vision online Help for more information and
instructions.
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After you initially configure Analysis Cubes, anytime that you change the Analysis Cubes
Configuration settings in Vision, you must also complete steps in the Vision Resource Kit. See the
"Analysis Cubes Configuration Changes in Vision" section of this guide for more information.

Apply Analysis Cubes Configuration that You Entered in Vision
Complete this step only if you purchased and activated the Vision Performance Management
module.
Step 4: Apply Cubes Configuration in the Resource Kit applies the Analysis Cubes settings
that you made for the data cubes in Vision Configuration » General » Analysis Cubes and in
Vision Configuration » General » User-defined Components » Fields tab. These settings
include the dimensions and measures selected to populate the data cubes and key performance
indicators (KPIs), calculated measures, currency exchange information, and user-defined fields
for the data cubes.
You must save the Analysis Cubes Configuration settings in Vision after you check
prerequisites, create and populate the data warehouse and data cubes, and apply system labels
in previous steps in the Resource Kit. If you save the configuration settings in Vision before you
perform these steps in the Resource Kit, KPI defaults will not be created in the data cubes.

To apply the configuration for Analysis Cubes from Vision Configuration, complete the
following steps:
1. In the Resource Kit, navigate to the Analysis Services tab on the Database tab, and click
the Step 4: Apply Cubes Configurations button to apply the settings in Vision Analysis
Cubes Configuration to the data warehouse and data cubes.
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2. On the dialog box that informs you that you are about to make structural changes to the
Analysis Services database, click Yes to continue.

3. When you receive a message on the Vision Business Intelligence dialog box that all of
the components were successfully applied, click Close.

After you initially configure Analysis Cubes, whenever you make any changes to the Analysis
Cubes configuration in Vision Configuration » General » Analysis Cubes or in Vision
Configuration » General » User-Defined Components » Fields tab, you must repeat the
Resource Kit Step 4: Apply Cubes Configuration and Step 5: Populate DW and Vision
Cubes. See “Chapter 4: Ongoing Analysis Cubes Configuration Maintenance” on page 53 for
specific instructions.

Populate the Data Warehouse and Data Cubes
In the Resource Kit, repeat Step 5: Populate DW and Vision Cubes. See the "Populate the
Data Warehouse (DW) and the Vision Cubes" section on page 28 for instructions.
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Validate that the Analysis Cubes Configuration Completed
Successfully
Connect to your SQL 2008 or SQL 2008 R2 Database Engine and Analysis Services to confirm
that:


The Vision data warehouse, analysis cubes, and SQL Server agent job to refresh them
are created.



The Vision data warehouse and analysis cubes are populated correctly.



The Vision analysis cubes are processed as part of the execution of the SQL Server
agent job.

Connect to Your SQL 2008 or 2008 R2 Database Engine and Analysis
Services
To connect to your SQL 2008 or SQL 2008 R2 Database Engine and Analysis Services,
complete the following steps:
1. Click Windows Start » All Programs » Microsoft SQL Server 2008 or Microsoft SQL
Server 2008 R2 » SQL Server Management Studio.
2. On the Connect to Server dialog box, complete the following steps:
a. In the Server Type field, select Database Engine.
b. In the Server Name field, select your SQL server (and instance, if applicable).
c.

Connect using a Windows account that is a member of the SQL Server sysadmin
role.

3. Click the Connect button.
4. In the Connect drop-down list in the Object Explorer window, select Analysis Service.
5. Select your Analysis Server as the server name.

Confirm that the Vision Data Warehouse, Analysis Cubes, and SQL Server
Agent Job Are Created
After you connect to your SQL 2008 or SQL 2008 R2 Database Engine and Analysis Services,
confirm that the following items are added to SQL Server 2008 or SQL Server 2008 R2:


The Vision data warehouse displays in the Databases folder of the SQL Server Database
Engine in Microsoft SQL Server Management Studio. The name of the data warehouse is
your Vision database name with DW appended to it.
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The Refresh <Vision data warehouse name> <language>DW and Cubes job displays
in the SQL Server Agent Jobs folder.



Deltek Vision Analysis displays in the Databases folder of Analysis Services.
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Validate that the Vision Data Warehouse and Analysis Cubes Are Populated
To confirm that the Vision data warehouse and analysis cubes are populated, complete the
following steps:
1. In the SQL Server Agent Jobs folder, right-click the Refresh <Vision data warehouse
name> <language> DW and Cubes job, and select View History from the shortcut
menu.

On the Log File Viewer dialog box, you see a green check mark beside the date of the
Refresh <Vision data warehouse name> <language> DW and Cubes job if the Vision
data warehouse and data cubes were populated correctly.
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If you see a red
instead of a green check mark, it is possible that there is a problem
with the environment variables that are required for the Integration Services packages to
read the configuration data.
2. Complete the troubleshooting steps below for environmental variables.

Troubleshooting steps:
a. In SQL Server Management Studio, validate that the environment variable exists in
System Properties » Advanced » Environment Variables.
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b. At a command prompt, enter set.
In the Select Command Prompt dialog box, the VisionETL_Configuration
environment variable should read as follows:
Vision ETL_Configuration=C:\Program Files <x86>\Deltek\Vision\Analysis\ETL_2K8\
VisionETL_Config.dtsconfig

If the VisionETL_Configuration environment variable reads %VisionETL_Root_Dir%
and not the full path to the VisionETL_Config.dtsconfig file, then it is likely that the
server was not rebooted after the environment variables were set by the Vision
database tier installation. Reboot your server.
The default schedule for the SQL agent job runs every night at 12:00 am. If this schedule
interferes with your nightly backup or any other processing or SQL agent scheduled jobs, you
can modify the job to run at an appropriate time for your environment.

Validate that the Vision Cubes Are Processed Via the SQL Server Agent
Job
To validate that the Vision Project and General Ledger cubes are processed as part of the
execution of the SQL Server agent job, complete the following steps:
1. In SQL Server Management Studio, connect to Analysis Services.
2. In the Object Explorer pane, in Analysis Services, navigate to Databases » Deltek
Vision Analysis - <Your Vision Database Name> » Cubes. In the following example,
the Vision database name is Vision Demo70ML; the Analysis Services database is Deltek
Vision Analysis – Vision Demo70ML.
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3. In the Cubes folder, right-click the Project OLAP Cube folder, and select Properties from
the shortcut menu.
In the Status section of the Cube Properties – Project Cube dialog box, the State
displays Processed. The cubes must be in a processed state for you to be able to
connect to them.

4. If the state displays Unprocessed, connect to the SQL Database Engine using SQL
Management Studio and manually run the SQL Agent job. To do this, right-click the job,
and click Start Job at Step.
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5. On the Start Job on dialog box, select step ID 1 and click Start.

You see the following Start Jobs dialog box as it processes.

6. When the process completes successfully, click Close on the Start Jobs dialog box.
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A successful completion of the SQL Agent refresh job automatically processes both the
Project and General Ledger data cubes.

Create an Analysis Services Role for Your Domain Users
You must create an Analysis Services role so that the domain users who create Vision custom
reports have access to the Vision Analysis database—the data cubes.
To create an Analysis Services role, complete the following steps:
1. Use SQL Server Management Studio to connect to Analysis Services.

2. In Object Explorer, navigate to Databases » Deltek Vision Analysis » Roles.
3. Right-click Roles, and select New Role from the shortcut menu.
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4. On the General page of the Create Role dialog box, complete the following actions:


Enter a name in the Role name field.



Select the Read definition check box for the database permissions for the role.

5. On the Membership page, add the domain users whom you want as members of the
Analysis Services role.
Your network administrator may find it easier to create a domain group that contains all
the necessary domain users. If this is the case, you must add the domain group and
not each individual domain user.
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6. On the Data Sources page, select Read in the Access field for the Vision data
warehouse.
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7. On the Cubes page, select Read in the Access field for each Vision OLAP cube.

8. Change the Local Cube/Drillthrough setting to Drill through for each Vision OLAP
cube.
9. On the Create a Role dialog box, click OK to complete the creation of the role.

Script the Role
After you create an Analysis Services role for Vision Analysis Cube users, Deltek recommends
that you script the creation of the role so that it can be easily recreated. This will be useful to have
when you upgrade to a new version of Vision and, if at some point, you may need to rebuild the
Vision data warehouse and data cubes rather than refresh them. When you rebuild them, any
Analysis Service roles that you previously created for them are lost.
To save a role to a script, complete the following steps:
1. Use SQL Server Management Studio to connect to Analysis Services.
2. In Object Explorer, navigate to Databases » Deltek Vision Analysis » Roles.
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3. Right-click the role that you created for Analysis Cubes, and click Script Role as »
CREATE To » File on the shortcut menu.

4. On the Select a file dialog box, save the file as an .XMLA file type to a location on your
server.
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5. If you must recreate the role, open the .XMLA file while you are connected to Analysis
Services, and run it against your Analysis Services database. This script recreates the
role name and the domain users that are members of the role. You then must reassign
access to the data source and the data cubes as in steps 6 and 7 in the "Create an
Analysis Services Role for Your Domain Users" section of this document.
The .XMLA file looks similar to the following:

You have completed the Analysis Cubes configuration.

If you want users to be able to access Vision OLAP cubes via the Internet (from outside a
corporate firewall), you must perform the additional configuration steps that are provided in
“Chapter 5: Configure Analysis Cubes for Internet Accessibility" on page 54.

Multiple Vision Databases
The Vision Resource Kit supports deploying cubes for multiple Vision databases. After you follow
the Analysis Cubes configuration instructions to create data cubes for one Vision database,
repeat all the configuration steps to create data cubes for each of your additional databases.

Multiple Languages
Languages Supported for Analysis Cubes
Vision supports the creation of data cubes in all the supported languages that can be enabled
with the Vision Multilingual module.

Vision Data Cubes for Each Language
To create custom reports in multiple languages, you must create separate Vision data cubes for
each language. To create data cubes for a different language, you repeat the configuration steps
in this guide. In the Vision Resource Kit, you select a different language on the Analysis Services
tab. The configuration steps are listed in the “Check Prerequisites,” “Create the Vision Data
Warehouse and Data Cubes,” “Apply System Labels to the Data Cubes,” and “Populate the Data
Warehouse (DW) and the Vision Cubes” sections of the guide.
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When you create a custom report in Excel, you connect to the data cube with the desired
language. For example, a Vision English International analysis database that contains the data
cubes has _en-GB at the end of its name.
Excel Data Connection Wizard with an English International data cubes database:

English International Language and Custom Reports in Excel
Users who connect to the English International data cubes in Excel must perform an additional
step so that the Vision dimensions, measures, and system labels display in the English
International language in the Excel PivotTable Field List. For this additional step, users must add
a locale identifier code to the connection string in the .odc file for each of the Project and General
Ledger data cubes. This step needs to be completed only once for each data cube. The steps are
included here and in the Analysis Cubes help in the Vision Help system.
To add a locale identifier code to the connection string in a data cube .odc file, complete
the following steps:
1. In Excel, connect to the Vision English International Project or General Ledger data cube.
2. Use Windows Explorer to navigate to the following location:


For the Windows XP: c:\Documents and Settings\<username>\My Documents\My
Data Sources



For Windows 7: c:\Users\<username>\My Documents\My Data Sources

3. In the My Data Sources folder, right-click the .odc file for the English International data
cube.
The file has the following naming convention:


Project data cube: <your Vision server name> Deltek Vision Analysis <your Vision
database name>_en-GB Project OLAP Cube.odc
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General Ledger data cube: <your Vision server name> Deltek Vision Analysis <your
Vision database name>_en-GB General Ledger OLAP Cube.odc
You must have Excel open and connected to a Vision English International
data cube for this file to display in Windows Explorer.

4. On the shortcut menu, click Edit in Notepad.
5. In Notepad, find the following odc: ConnectionString line:
<odc:ConnectionString>Provider=MSOLAP.4;Integrated Security=SSPI;Persist Security
Info=True;Data Source=camdbprd4\sql2008r2;Initial Catalog=Deltek Vision Analysis <your database name>_en-GB </odc:ConnectionString>
6. Add ;Locale Identifier=2057 to the end of the string as follows:
<odc:ConnectionString>Provider=MSOLAP.4;Integrated Security=SSPI;Persist Security
Info=True;Data Source=camdbprd4\sql2008r2;Initial Catalog=Deltek Vision Analysis VisionEuropaQCMCMCML_Cubes_fr-FR;Locale Identifier=2057</odc:ConnectionString>
Note the semicolon before Locale Identifier=2057.
7. Save and close the file in Notepad.
In Excel, the Vision dimensions, measures, and system labels in the PivotTable Field list for the
data cube now display in the English International language.

Producing Reports in Both the English United States and English
International Languages
If you want to produce the same report in both the English United States and English International
languages, you can use one .xlsx Excel report file for both reports. However, if you have Vision
system labels that are different for each language, any dimensions added to the report design
that have a system label in their name are removed from the .xlsx file when you are connected to
the English International language and open the report. In that scenario, you need to add the
missing dimension back to the report, or you could create a separate .xlsx Excel report file for
each language.
An example of different systems labels is having “job” set up as the system label for WBS (work
breakdown structure) 1 in the English United States Vision data base and “project” set up as the
system label for WBS 1 in the English International Vision data base.
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Chapter 3: Troubleshoot Analysis Cubes
Deployments
You must meet many pre-requisites and complete many individual steps to deploy Vision
Analysis Cubes successfully. In addition, there may be data-related issues during the process
because data is copied and transformed from your Vision transaction database to the data
warehouse and then to the Analysis Services database. Failures can occur during any of these
steps.
The following table provides some basic troubleshooting information.
Step Where You Encounter Problems

What to Do

Step 1: Check Pre-requisites in the Resource
Kit

Review the pre-requisite requirements at the
beginning of this guide.

Step 2: Setup in the Resource Kit

Ensure that you have upgraded the Vision
database tier installation to Vision 7.1.

Step 3: Apply System Labels to Cubes

Review the DeltekVisionResourceKit.log file in
the \Vision\Logs folder. To access this log in
Resource Kit directly, click File » View Log. If
you need to open a Customer Care incident,
be sure to include this log file.

or
Step 4: Apply Cubes Configurations in the
Resource Kit
Step 5: Populate DW and Vision Cubes in the
Resource Kit

If you need to create a more detailed output
file, modify the SQL Server Agent job. See the
instructions that follow on how to enable the
detailed output log.
If the SQL Server Analysis Services service
account does not have the necessary rights to
the Vision data warehouse database, the SQL
Agent refresh job in step 5 will fail. For more
information, see the “Reconfigure the SQL
Server Analysis Services Service Account”
section on page 23.

Run the SQL Agent Refresh Job on SQL
Server 2012 with an earlier version of SQL
Server also installed, and you receive an error.
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Enable the Detailed Output Log
Use the detailed output log to troubleshoot failures in the Analysis Cube SQL Agent refresh job.
This log is created only if you complete the instructions in this section.
When you installed Microsoft SQL Server, if you used the default service accounts that were
provided, the SQL Server Agent Refresh Job account runs as “NT Service\SQLServerAgent.”
This account does not have the necessary rights to the file system on the server for the Vision
Analysis Cubes detailed output log to be created. To enable the necessary rights to create the
detailed output log, you must reconfigure the SQL Agent service to run as a domain account that
has modify rights to the Vision Logs folder. Then follow the steps below to enable the detailed
output log. If you enable the detailed output log, but the SQL Server Agent Refresh Job account
does not have the necessary rights, you will see an error in the job history log about the service
account being denied access to the Vision logs folder. (To open the history log, you right-click
the SQL Agent job, and click View History from the shortcut menu.)

To enable the detailed Analysis Cubes output log, complete the following steps:
1. Open SQL Server Management Studio, and connect to the database engine.
2. Expand the SQL Server Agent folder, and then expand the Jobs folder.
3. Locate the SQL Agent job that is named “Refresh <Vision Database> <language> DW
and Cubes” (for example: Refresh VisionDemo70ML en-US DW and Cubes).

4. Right-click the job, and click Properties on the shortcut menu.
5. Click the Steps page, select step ID 1, and then click the Edit button.

Installation and Configuration Guide for Performance
Management

49

Chapter 3: Troubleshoot Analysis Cubes Deployments

6. Select the Advanced page, and in the Output file field, enter or browse to the path for
the Vision logs directory. Then add a log file name to the path in the Output field (for
example: output.log) and click OK.

7. On the Advanced page, click OK to return to the Steps page.
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8. On the Steps page, click OK.
9. Manually run the SQL Server Agent job. To do this, right-click the job in the Jobs folder,
and choose Start Job at Step… from the shortcut menu.

10. On the Start Job on dialog box, select step ID 1, and click Start.
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You see the following Start Jobs dialog box as the SQL Server Agent job runs:

11. After the job finishes successfully, click Close.

12. When the SQL Server Agent job is complete, retrieve the output log that you created in
step 6. Include it in your Customer Care case submission.
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Chapter 4: Ongoing Analysis Cubes Configuration
Maintenance
After you initially configure Analysis Cubes, whenever you make changes to Vision system labels
or to Analysis Cubes configuration settings in Vision, you must repeat some Analysis Cubes
configuration steps.

System Label Changes in Vision
Whenever you make a system label change in Vision (Configuration » General » System
Settings » Labels tab), you must rebuild the data cubes. To rebuild them, you first delete the
existing data warehouse (DW), SQL Server agent job, and Analysis Services database. Then you
complete all the Analysis Cubes configuration steps. See Chapter 2: Configure Analysis Cubes
for instructions.
If you only rerun Step 3: Apply System Labels to the Cubes in the Vision Resource Kit after
you change a system label in Vision, the labels are not correctly reapplied in the data cubes.

Analysis Cubes Configuration Changes in Vision
Anytime that you make changes to the following Analysis Cubes configuration in Vision, complete
the Resource Kit steps below to update the Analysis Cubes data cubes:


Vision Configuration » General » Analysis Cubes — Dimensions and measures
selected to populate the data cubes, KPIs, calculated measures, and currency exchange
information)



Vision Configuration » General » User-Defined Components » Fields tab —
User-defined fields to populate the data cubes.
You can access Analysis Cubes configuration only if you purchased and activated the Vision
Performance Management module.

To update the data cubes with the current Analysis Cubes configuration entered in Vision,
complete the following steps:
1. Open the Vision Resource Kit. See page 17 for specific instructions.
2. Navigate to the Analysis Services tab on the Database tab.
3. In the Setup section, click Step 4: Apply Cubes Configurations. See page 31 for
specific instructions.
4. Run Step 5: Populate DW and Vision Cubes in the Resource Kit. See instructions on
page 32, or run the SQL Agent refresh job in SQL Server Management Studio to refresh
your data warehouse and cubes.
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Chapter 5: Configure Analysis Cubes for Internet
Accessibility
If you want users to be able to access Vision OLAP cubes via the Internet (from outside a
corporate firewall), complete the configuration steps in this section. Using these instructions, you
will configure Internet Information Services (IIS) to allow Microsoft Excel to access Analysis
Services via HTTP.
You must complete the instructions in the previous sections of this guide to configure Analysis
Cubes first, before you complete the instructions in this section to configure Analysis Cubes for
Internet accessibility.

Install and Configure the OLAP Data Pump
You can perform the following steps on any server running IIS that has been configured to be
allowed access from the Internet and configured to have access to the Analysis Services
database. In many cases, this may be the Vision Web/application server.
Windows Integrated Authentication will not work with Excel if users are not authenticated to the
domain. Therefore, for this to work for Internet users, the OLAP virtual directory must be
configured for Basic Authentication. With Basic Authentication, users still enter their domain
credentials, but they are passed in clear text. For this reason, you must secure the Web site that
is hosting the OLAP virtual directory with an SSL certificate.

The OLAP Data Pump component is loaded into IIS and serves as an ISAPI extension to pump
data from the client to an Analysis Services server and back. The following diagram provides a
high-level overview of the component architecture.

You must configure the OLAP Data Pump if you are configuring the Analysis Cubes to be
accessed by Excel for Internet users.
The following steps guide you through installing and configuring the Microsoft OLAP Data Pump.

Step 1: Get Binaries
Copy the contents of the %SSAS Installation folder%\OLAP\bin\isapi folder into the folder that
you want to serve as the base for the virtual directory in IIS.
In this example, we copy all the files from the C:\Program Files\Microsoft SQL
Server\MSAS10.MSSQLSERVER\OLAP\bin\isapi folder into the C:\inetpub\wwwroot\olap folder.
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The following apply:


To take advantage of the full set of security settings, it is important to make sure that the
folder that serves as the base for the virtual directory is located on the drive that is formatted
for the NTFS file system.



Due to IIS limitations, the path to your directory must not contain spaces.



If you plan to run the HTTP pump on a different server than the Analysis Services server, you
must also install OLEDB for Analysis Redistributable package for your version and platform of
SQL Analysis Services on the Web server hosting the OLAP Data Pump. Refer to “Configure
Settings if Data Pump and SSAS Are on Different Servers” on page 61.

Step 2: Create an Application Pool
To create an application pool, complete the following steps:
1. Click Windows Start » Control Panel » Administrative Tools » Internet Information
Services to open the IIS Manager.
2. In the IIS console, expand the Server Name node.
3. Right-click Application Pools, and click Add Application Pool on the shortcut menu.
4. On the Add Application Pool dialog box, complete the following:


In the Name field, enter a name for the application pool. In this example, it is olap.



In the .Net Framework version field, select .NET Framework v2.0.5027.



In the Managed pipeline mode field, select Classic.

Step 3: Create a Virtual Directory
To create a virtual directory, complete the following steps:
1. In the Connections pane of the IIS console, expand Sites, and then expand Default Web
Site (or the site name that you use).
2. Right-click the Web site, and click Add Application on the shortcut menu.
3. On the Add Applications dialog box, complete the following:


In the Alias field, enter the name for the virtual directory. In this example, we call it
olap.
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The content directory in the Physical path field must point to the folder that you
created.

4. Click OK to create the application.
5. In the Connections pane, click the OLAP virtual directory, and double-click Handler
Mappings in the /OLAP Home pane.

Installation and Configuration Guide for Performance
Management

56

Chapter 5: Configure Analysis Cubes for Internet Accessibility

6. In the Actions pane on the right, click Edit Feature Permissions.

7. On the Edit Feature Permissions dialog box, select the Read and Script permissions
check boxes if they are not selected, and click OK.
8. In the Actions pane, click Add Script Map….
9. On the Edit Script Map dialog box, complete the following, and then click OK.


In the Request path field, enter *.dll.



In the Executable field, browse to and select the location of the msmdpump.dll file.
For multiple instances, be sure to point to the appropriate physical instance folder.



In the Name field, enter OLAP.
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10. On the Add Script Map dialog box, click Yes to add the ISAPI extension and save the
settings.

11. To see the ISAPI extension that was added, click the Server Name node in the IIS
console, and double-click ISAPI & CGI Restrictions.

12. In the ISAPI and CGI Restrictions pane, double-click OLAP Data Pump.
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Step 4: Configure Security for Excel Access over the Internet
Before you begin the following procedure to configure security for Excel access over the internet,
enable Basic Authentication in your IIS configuration if it is not currently enabled. To do so, go to
Server Manager » Roles » Web Server (IIS) » Add Role Services.

To configure security for Excel access over the Internet, complete the following steps:
1. In the Connections pane of IIS Manager, select the OLAP virtual directory.

2. In the /OLAP Home pane, double-click Authentication.
3. In the Authentication pane, select Basic Authentication.
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4. In the Actions pane, click Enable and then click Edit.
5. On the Edit Basic Authentication Settings dialog box, configure the default domain:

6. If it is appropriate, disable Anonymous Authentication and Windows Authentication.

Step 5: Select the Target Analysis Services Server
As the architectural diagram on page 54 shows, every instance of the OLAP Data Pump uses its
own configuration file.
Open the msmdpump.ini file in your folder. The contents of the file should look like the following:
<ConfigurationSettings>
<ServerName>localhost</ServerName>
<SessionTimeout>3600</SessionTimeout>
<ConnectionPoolSize>100</ConnectionPoolSize>
<MinThreadPoolSize>0</MinThreadPoolSize>
<MaxThreadPoolSize>0</MaxThreadPoolSize>
<MaxThreadsPerClient>4</MaxThreadsPerClient>
</ConfigurationSettings>
The only setting of interest, at this point, is <ServerName>. If the Analysis Services instance to
which you must provide access is located on the local machine and installed as a default
instance, you have no reason to change this setting. If it is not located and installed in this way,
you must specify the machine name and instance name (mymachine\inst1).
The key setting at this point is <ServerName>. If the Analysis Services instance to which you
must provide access is located on the local machine and installed as a default instance, do not
change this setting. Otherwise, you must specify the machine name and instance name:
<ServerName>mymachine\inst1</ServerName>

Installation and Configuration Guide for Performance
Management

60

Chapter 5: Configure Analysis Cubes for Internet Accessibility

Step 6: Get it All Together
At this point, your HTTP pump is configured, and you can connect from your application.
If your application provides a way to specify the server name, replace your server name with the
path to your virtual directory concatenated with msmdpump.dll. For example:
http://MyMachine/olap/msmdpump.dll
After you install the Microsoft OLAP Data Pump, complete the following tasks:


Configure settings, if the data pump and OLAP are not on the same server.



Test the data pump configuration.

Configure Settings if Data Pump and SSAS Are on Different Servers
If the data pump and SSAS are not on the same server, install the following prerequisite software
components:


Microsoft Core XML Services (MSXML) 6.0 (required to install the OLE DB Provider)



Download the appropriate feature pack files for your version and platform of SQL Server
Analysis Services.
For example:


If you are using SQL Analysis Services 2008 SP2: Microsoft SQL Server 2008
Analysis Services 10.0 OLE DB Provider.
See http://www.microsoft.com/download/en/details.aspx?id=6375



If you are using SQL Analysis Services 2008 R2 SP1: Microsoft SQL Server 2008 R2
Analysis Services 10.0 OLE DB Provider.
See http://www.microsoft.com/download/en/details.aspx?id=26728
Important: Download the correct platform version (x86 or x64) to match your
installation of SQL Analysis Services and IIS.

Modify the ServerName setting in the msmdpump.ini file to point to the location of the SSAS
server. Change localhost to the name of your SSAS server, including the instance name if
applicable:
<ConfigurationSettings>
<ServerName>localhost</ServerName>
<SessionTimeout>3600</SessionTimeout>
<ConnectionPoolSize>100</ConnectionPoolSize>
</ConfigurationSettings>
Test the Data Pump Configuration
Complete the following actions to test the data pump configuration:


Test the URL.



Test the connection using SQL Management Studio.



Test the connection using Excel.
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Test the URL
To test the URL to ensure that the data pump is set up correctly, complete the following
steps:
1. Access the data pump URL (http://<IISServer>/<OLAPVirtual>/msmdpump.dll) .
2. Go to Internet Explorer Advanced Settings.
3. Clear the Show friendly HTTP error messages check box. The following information
displays:
<soap:Envelope xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/">
<soap:Body>
<soap:Fault xmlns="http://schemas.xmlsoap.org/soap/envelope/">
<faultcode>XMLAnalysisError.0xc10e0002</faultcode>
<faultstring>Parser: The syntax for 'GET' is incorrect.</faultstring>
<detail>
<Error ErrorCode="3238920194" Description="Parser: The syntax for 'GET' is incorrect."
Source="Unknown" HelpFile="" />
</detail>
</soap:Fault>
</soap:Body>
</soap:Envelope>
Though the information above reflects an error, this message indicates that the data pump is
configured correctly.

If the information above does not display in the browser, check the Application Event log on the
server for errors.
Test the Connection Using SQL Management
You can use HTTP and SQL Server Management Studio to test the data pump connection to the
Vision Analysis Cubes.
However, you cannot test the connection using SSMS if you chose Windows Integrated
Authentication for the IIS virtual directory. In that case, you can temporarily set the IIS virtual
directory permissions for Anonymous Access and test the configuration. Remember to change
the Anonymous Access account to a user account that has read access to the Vision Analysis
Cubes. After you complete the test, enable Windows Integrated Authentication again.
Test the Connection Using Excel
You can use HTTP and Microsoft Excel to test the data pump connection to Vision Analysis
Cubes. However, you cannot test the connection using Excel if you chose Windows Integrated
Authentication for the IIS virtual directory. In that case, you can temporarily set the IIS virtual
directory permissions for Anonymous Access and test the configuration. (Remember to change
the Anonymous Access account to a user account that has read access to the Vision Analysis
Cubes. After you complete the test, enable Windows Integrated Authentication again.
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Configure the Data Source in Excel
After you configure IIS per the “Install and Configure the OLAP Data Pump” section, Internet
users can use the URL when they configure the data source in Excel.
To configure the data source in Excel, complete the following steps:
1. In Excel 2007, click the Data tab, and then click From Other Sources » From Analysis
Services.

On the Connect to Database Server page, enter the following information and click Next:


In the Server name field, enter the URL (http://<IISServer>/olap/msmdpump.dll).



Select the Use the following User Name and Password option.



In the User Name field, enter the user name (in form of domain\user).
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2. On the Select Database and Table page, select the database from the drop-down list,
select the cube that you want to connect to, and then click Next.

3. On the Save Data Connection File and Finish page, select the Save password in file
check box and click Finish.
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When you select the Save password in file check box, your domain password is
saved in clear text in the data source connection file, which is a potential security risk.
However, not selecting the check box presents the following issues depending on your
operating system:



If you use Windows XP or Windows 7 as the workstation operating system,
you are prompted to re-enter the password.



If you use Windows Vista, you must select this option in order to proceed.

4. On the Import Data dialog box, click OK.

If you did not select the Save password in file check box in Step 4, the following
Installation of the data source failed error may display:

If you use Windows Vista and you do not select the Save password in file check box,
the following error displays and you are not able to access the cube data.

5. Click OK.
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6. On the Multidimensional Connection 9.0 page, re-enter your password and click Next.

7. On the Select the database that you want to work with page, click Finish to begin using
the cube data in Excel.
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If you select the Save password in file check box, a dialog box with the following
question displays:
The password is saved without encryption in an Office Data Connection text
file, making your data less secure. Are you sure you want to save the
password?

The data source is stored locally on your hard drive in My Documents\My Data Sources
as an .odc file. The contents of this file, including the password (if saved), is stored in
clear text.

Installation and Configuration Guide for Performance
Management

67

Chapter 6: Performance Management Dashboards Installation and Configuration

Chapter 6: Performance Management Dashboards
Installation and Configuration
With Tableau Server and Tableau Desktop (products of Tableau Software, Inc.), you can use
Vision Project Cubes and General Ledger Cubes data sets and analysis services to create rolebased graphical performance dashboards. These performance dashboards can then be added as
Web dashparts on the Vision Dashboard.
You must complete the installation and configuration steps in this chapter to use Tableau
Server/Tableau Desktop with Deltek Vision.

Note on Terminology
Tableau uses the following key terms in its software and supporting documentation:


Workbook — A workbook is basically a Web page that functions as a container for
displaying a set of Views.



View — A view is a chart or table that provides a graphical representation of the values
of the critical metrics that you select for that chart or table.

Because these terms are generally not familiar to users of business intelligence software
applications, Deltek replaced them with more common terms in the Vision online help and other
documentation developed for those who use Vision Performance Management. “Dashboard” and
“chart” are used instead of “workbook” and “view.”
However, because it focuses on installing, configuring, and using the Tableau Server/Tableau
Desktop software itself, this installation guide uses the original Tableau terms.
As you use Tableau, you may encounter the additional terms listed below. Though many of these
are not used in Vision Performance Management, being familiar with them will help you
understand and work with Tableau and the Tableau documentation:


Site — A logical security separation of workbooks, views, and users. Sites are used with
Vision Performance Management to provide access to different Analysis Cubes for
customers who have multiple Vision databases (for example, a production database and
a test database,) or for customers who have the Vision Multilanguage feature and want
Analysis Cubes and performance dashboards in multiple languages. See “About Tableau
Sites” on page 89 for more information.



Project — A collection of related workbooks. Vision Performance Management does not
use projects.



Groups — A method for grouping users to make it easier to assign permissions. Vision
Performance Management does not use groups.



Data Sources — A reliable connection to data. Vision Performance Management does
not use data sources.



Data Connections — Every workbook that is published to the server contains a data
connection. The data connection information is embedded into each workbook during the
publishing process using the Deltek Vision Resource Kit.



Schedules — Used with server side tasks. Vision Performance Management does not
use schedules.



Tasks — Jobs performed by Tableau Server. Vision Performance Management does not
use tasks.
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Subscriptions — A subscription is a view or workbook on Tableau Server that users can
receive a snapshot of via email. Subscriptions are not used with Vision Performance
Management.

Logical Tier Model

Deploy Deltek Vision 7.1 with Analysis Cubes
Before You Begin
Before you install the Tableau Server software, you must configure the Vision Analysis Cubes.
Data for the workbooks is based on the Analysis Cubes, not the Vision database. See “Chapter 2:
Configure Analysis Cubes” on page 10 for more information.
The following additional prerequisites must also be met:


Install or upgrade Vision, including the database tier, to Vision 7.1. The installation
process installs or upgrades the Analysis Services files, sample workbooks, and Deltek
Vision Resource Kit. It also copies the Tableau Command Line Utility setup which the
Resource Kit requires in order to publish the workbooks. The Tableau Command Line
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Utility must be installed before attempting to publish workbooks. See “Publishing Tableau
Sample Workbooks” on page 80 for more information.


Deploy Vision 7.1 Analysis Cubes. If you have existing Vision 7.0 Analysis Cubes
deployed, the Resource Kit prompts you to overwrite them. If you have Vision 6.x
Analysis Cubes, see “Delete Your Existing Data Warehouse and Data Cubes” on page
14.



Review and identify your Vision Performance Management tier configuration. Deltek
recommends that you install Tableau Server on a dedicated server. Review the
requirements for the server hosting Tableau Server
(http://www.tableausoftware.com/products/server/specs) and contact Deltek Sales
Engineering for assistance in determining the optimal configuration for your firm.
For related information, see the following:


“Distributed Environments” in the Tableau Server 8.0 Server Admin Guide



“Virtual Environments” on the “Technical Specifications – Tableau Server” page
(http://www.tableausoftware.com/products/server/specs)
If you install Tableau Server on a server that does not meet the minimum system
specifications, you will receive a warming similar to the following:
-- Verification result: WARNING
Setup can proceed, but this system does not meet the minimum recommended
Tableau Server requirements: http://www.tableausoftware.com/products/server/specs
If you proceed, Tableau Server may not perform to expectations.
Reason:
Processor (cores): 1 (minimum recommended is 2)
Memory: 2 GB (minimum recommended is 4 GB)
Other resources found:
Available disk space: 14.52 GB
Operating System: Microsoft Windows Server 2008 R2 Enterprise Service Pack 1



Download Vision 7.1 VPM Installer from DSM.



Review the following Deltek-specific configuration notes:


Licensing — You must have a license for Vision Performance Management to
deploy Tableau Server workbooks. The Tableau Server and Desktop license keys
are provided by Deltek as part of Vision Performance Management. If you have not
received them, contact your Account Manager.



Authentication — Decide on an authentication method before proceeding. If you
need to change the authentication method later, you must uninstall and reinstall
Tableau Server. See “Tableau Security Configuration” on page 73 for additional
information.



Support — Use Deltek Customer Care for all product support needs. You will not be
able to contact Tableau Software Support directly.
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Identify Deployment Strategy
Before you install the server software, consider the following questions:


Where will you install the Tableau Server software?



What type of security will you use?



Do you need to install the Microsoft OLAP Data Pump?



Will the performance dashboards or Tableau Server be accessed by Internet clients?



Does your Vision deployment support multiple databases or multiple languages?

Where will you install the Tableau Server software?
Before you install the Tableau Server software on a server, review Tableau Server technical
specifications at http://www.tableausoftware.com/products/server/specs. Deltek does not
recommend installing the Tableau Server software on any Deltek Vision tier.
What type of security will you use?
The security that you choose for Tableau Server largely depends on the security you
implemented for Vision. Vision supports two methods of authentication:


Vision Security — If you use Vision security (application-level users and passwords),
you must use Local authentication when you configure Tableau Server.



Windows Integrated Authentication - If you use Windows Integrated security for Vision,
your users authenticate to Vision using their Active Directory login. In this case, you must
use Active Directory authentication when you configure Tableau Server.

You do not need to change your Vision security model to implement the Tableau Server software.
If you use Windows Integrated Authentication with Vision but also have Vision security users,
those users will not be able to access the performance dashboards.

See “Tableau Security Configuration” on page 73 for more details on security.

Do you need to install the Microsoft OLAP Data Pump?
The Microsoft OLAP data pump is a Web server extension installed in IIS. The OLAP data pump
is only required under the following circumstances:


Internet users outside of your network (not VPN users) need to connect Tableau Desktop
to the Vision Analysis Cubes to create custom workbooks.



Users outside of your network need to connect to the Analysis Cubes with Excel.

For installation and configuration instructions, see “Chapter 5: Configure Analysis Cubes for
Internet Accessibility” on page 54.
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Will Tableau Server software or Vision performance dashboards be accessed by Internet
clients?
If your current deployment allows users to access Vision directly over the Internet (excluding
access through a VPN), and users also need to access the Vision Performance Management
dashboards over the Internet, do the following:


Configure your firewall to allow the port used by the Tableau Server software to be
accessed. Note that this will typically require you to configure Tableau Server (and also
Vision) with an SSL certificate. See “Configure Tableau Server for SSL (Optional)” on
page 77 for more information.



Establish an Internet-accessible fully qualified domain name for that purpose (for
example, visiondashboards.company.com). That domain name must be resolved both
inside and outside the corporate network.

Does your Vision deployment support multiple databases or multi-lingual?
If your Vision deployment includes multiple databases (for example, a production database and a
test database) or you need to support Analysis Cubes and dashboards in multiple languages and
you need to use Vision Performance Management with more than one of those databases, you
must deploy a unique Data Warehouse/Cube database for each Vision database and/or language
that you need to support.
A single instance of Tableau Server supports multiple Analysis Cubes databases. To accomplish
this, you configure a unique Tableau “site” for each Analysis Cubes database. See “About
Tableau Sites” on page 89 for more information.

Microsoft SQL Server Edition Dependencies
Some of the Vision Analysis Cubes functionality is available only if you have Microsoft SQL
Server Enterprise Edition installed. (For details, see “Microsoft SQL Server Edition
Dependencies” on page 7.)
If you instead are using the Standard Edition, the limitation on Analysis Cubes functionality, in
turn, imposes these limitations on the sample performance management dashboards:




These dashboards are not available:


Organization Manager Sample – Accounts Receivable Trending



Principal Sample - Accounts Receivable Trending



Executive Sample – Days Outstanding Metrics



Organization Manager Sample – Days Outstanding Metrics



Principal Sample – Days Outstanding Metrics



Project Manager Sample – Days Outstanding Metrics

The Executive Sample – Accounts Receivable and Promotional Costs dashboard does
not display the AR Trend chart, and the dashboard name is changed to Executive
Sample – Promotional Costs,
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Summary of VPM Configuration Steps
The following are the primary steps required to configure Vision Performance Management.
Step

Where to Perform

Description

1

All Deltek Vision
servers

Install or upgrade to Vision 7.1.

2

Vision Resource Kit
on the Vision
database server

Deploy or re-deploy Deltek Vision Analysis Cubes for Vision 7.1.

3

Server hosting
Tableau Server

Identify Tableau security configuration.

4

Server hosting
Tableau Server

Install and configure Tableau 8.0 Server.

5

Server hosting
Tableau Server

Configure Tableau for SSL (optional).

6

Vision Resource Kit
on the Vision
database server

Publish sample workbooks to Tableau Server.

Vision Resource Kit
on the Vision
database server

Export Vision users to a .CSV file.

8

Tableau Server
Administration

Import Vision users into Tableau Server.

9

Tableau Server

10

Vision Dashboard /
Vision Reporting

7

Configure Trusted Authentication - if using Local (Tableau)
Authentication.
Test the performance dashboards.

Tableau Security Configuration
During the installation and configuration of Tableau Server, you must specify the type of
authentication that you will use. This authentication should match the authentication that you are
using for your Vision implementation. If you are using Windows Integrated Authentication with
Vision, configure Tableau Server for Active Directory security. If you are using Vision security,
select Local (Tableau) authentication.
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Active Directory
Once you add Active Directory users to Tableau Server (see “Add Domain Users” on page 86),
your users can view performance dashboards both in Vision and directly in Tableau Server.
If you are using Active Directory, make sure that you select Enable Automatic Login on the
Tableau Server Configuration dialog box. This setting is required for seamless access to the
dashboards from within Vision.
If you have users in domains outside of the domain that Vision and Tableau Server are members
of, and if those users require access to the Performance Management dashboards, a Domain
Trust relationship must exist between the domains such that the server domain trusts the user
domain.

Local Authentication
If you use Local (Tableau) authentication, the initial implementation of Vision Performance
Management is a single user authentication. Only one Tableau user account is needed.
(Essentially, all of the Vision Performance Management dashboards are “shared” among all of
your users, as authentication is performed under the context of a single user account. For more
information, see “Add Local (Tableau) Users” on page 86.
The following are the primary limitations of using Local authentication:


A feature of the performance dashboards, if you are using Active Directory, is that
individual users can save personal customized views of the dashboards they are working
with. With Local Authentication, a user can still save views but access to them is not
restricted to that user. All users who display a dashboard have access to all views
created for that dashboard.
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Under Active Directory, users can access the performance dashboards from within Vision
or directly on the server hosting Tableau Server. With Local Authentication, while it is
possible to add your regular Vision users to Tableau Server and provide them access to
the dashboards outside of Vision, the functionality of the dashboards will not be the
same. For example, when you access dashboards directly through Tableau Server, the
automatic role-based filters that are applied through Vision are not applied. As a result,
the dashboards, by default, display all data rather than being pre-filtered. In addition,
users will have access to all of the Tableau Server functionality when accessing the
dashboards directly.

Changing Tableau Security Configuration
Warning: If you install Tableau Server and then need to change the security configuration, it is
not possible to save any Tableau configuration settings or data. You must fully reconfigure the
environment.

If you install Tableau Server and later need to change the security configuration (from Active
Directory to Local Authentication or the reverse), you must uninstall the Tableau Server software
and also remove the following Tableau Server installation folders:


C:\Program Files (x86)\Tableau (Substitute the appropriate installation drive letter and
path, as appropriate.)



C:\ProgramData\Tableau (The ProgramData folder is a hidden Windows folder, so you
will need to change your folder and view settings to display it)

Upgrading Tableau Software
Tableau components that will require periodic updates include the following:


Tableau Server software.



Tableau Worker software (distributed environments only).



TabCmd command line utility. TabCmd is updated as part of the Deltek Vision database
tier installation.



Tableau Desktop software.

Tableau software component upgrades are not typical software upgrades, in that you must
uninstall the previous version before you can install the new one. However, the uninstall process
does preserve all previously installed configuration settings. In the case of Tableau Server, this
means that you will not lose any information (workbooks, users, or any other configuration
settings).
The Tableau software for Vision Performance Management is specifically branded for Deltek, and
Deltek must be your source for that software. Do not attempt to upgrade Tableau with software
from a source other than Deltek.

Install and Configure Tableau Server 8.0
Before you begin the installation process, read the Tableau Server 8.0 Administrator Guide. (This
guide is available for downloading with the Deltek Software Manager, along with the other Vision
Performance Management documentation.) Focus on the “Before you install…” and “Install and
Configure” sections so you have a thorough understanding of the installation and configuration
process.
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The Tableau Server 8.0 installation is embedded in the Deltek Vision Performance Management
for 7.1 installation (DeltekVisionPerformanceManagementFor71.exe). That installer installs the
Deltek-specific Vision Performance Management configuration on the server and launches the
Tableau Server 8.0 installation at the end of that process. Should you need to re-run the Tableau
Server 8.0 installation at a later time, the Tableau Server setup program is copied to <Vision
Installation folder>\Support\Tableau.
To install and configure the Tableau Server software, follow the instructions in the “Install and
Configure” section of the Tableau Server 8.0 Administrator Guide. The following steps summarize
the process and list the relevant section from the Administrator Guide:
1. Run Server Setup — This section describes how to install the Tableau Server software.
2. Activate Tableau — Activate Tableau Server with the license key that Deltek provides.
3. Configure the Server — Use the Tableau Server Configuration dialog box to configure
Tableau Server for your environment. The following provide additional guidance for
making key entries:
Warning: If you install Tableau Server and later need to change the security
configuration (from Active Directory to Local Authentication or the reverse), you must
uninstall the Tableau Server software and also remove the Tableau Server installation
folders. None of your configuration will be preserved. You must reinstall and
reconfigure Tableau Server.

Server Run As User — This entry must be a domain account that has rights to the
Analysis Cubes.
Whether you are using Active Directory or Local authentication this account must be a
domain account with rights to the Analysis Cubes.

User Authentication — Select Use Active Directory (recommended) or Use Local
Authentication (Tableau authentication). See “Tableau Security Configuration” on page
73 for more information.
Active Directory — If using Active Directory (domain) authentication, check Enable
Automatic Login. This is a Deltek Dashboard requirement to ensure seamless display of
the dashboards without requiring users to manually authenticate to Tableau Server.
Gateway — Choose the port that Tableau Server listens to for requests. Default is 80 if
IIS is not installed on the Tableau server, and 8000 if it is installed.
Open Port in Windows Firewall — If this is checked, Tableau Server will open the
specified port for incoming requests in Windows firewall.
Include Sample Data & Users — If this is checked, Tableau sample workbooks are
installed. Later you will need to delete them manually from Tableau Server. It is
recommended that you not select this check box when you configure your production
instance of Tableau Server.
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Local Authentication

Active Directory Authentication

Configure Tableau Server for SSL (Optional)
If your Vision server is configured to allow or require the use of SSL (https), you must also
configure the server hosting Tableau Server with an SSL certificate. As it does for reporting,
Vision requests dashboards using the same URL prefix (http or https) that was used to access
Vision.
If some users access Vision using SSL (https) and the server hosting Tableau Server is not
configured for SSL, those users cannot display the dashboards. However, users accessing
Vision internally using http will be able to access Tableau dashboards using SSL.

1. Refer to the “SSL” section in the Tableau Server 8.0 Administrator Guide. (This guide is
available for downloading with the Deltek Software Manager, along with the other Vision
Performance Management documentation.) Also refer to the following Tableau
knowledgebase article for steps on configuring SSL:
http://kb.tableausoftware.com/articles/knowledgebase/creating-ssl-certificate-and-keytableau-server
2. When you configure the server hosting Tableau Server for SSL, it only accepts requests
on the default SSL (https) port of 443. It automatically redirects non-SSL requests (http)
to SSL (https).
3. If Tableau Server is installed on the Vision Web or application server (or any other server
that is using port 443 for SSL communication), Tableau Server cannot be configured for
SSL because that requires port 443.
If you are using an SSL certificate obtained from an Internal Certificate Authority (for example,
Microsoft Active Directory Domain CA) you will receive errors when you attempt to publish
workbooks. See “Chapter 7: Troubleshoot” on page 95 for more on how to resolve this issue.
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Final Tableau Server Configuration
Several additional configuration steps are required after the initial Tableau Server installation and
configuration process:
1. Verify that the Analysis Services OLE DB drivers are installed on the server hosting
Tableau Server. Tableau Server cannot connect to the Analysis Cubes database without
these drivers. The Analysis Services OLE DB drivers are available in the SQL Server
Feature Pack for your platform (x86/x64), version (SQL 2008, 2008 R2 or 2012) and SQL
Server Service Pack. Be sure to use the correct version for your installation of SQL
Server. Links for the most recent SQL Server Service Pack Feature Packs are listed
below:
SQL 2008 SP3 Feature Pack
http://www.microsoft.com/en-us/download/details.aspx?id=27596
x86 - ENU\x86\SQLSERVER2008_ASOLEDB10.msi
x64 - ENU\x64\SQLSERVER2008_ASOLEDB10.msi
SQL 2008 R2 SP2 Feature Pack
http://www.microsoft.com/en-us/download/details.aspx?id=30440
x86 - SQLSERVER2008_ASOLEDB10_amd64.msi
x64 - SQLSERVER2008_ASOLEDB10_x86.msi
SQL 2012 SP1 Feature Pack
http://www.microsoft.com/en-us/download/details.aspx?id=35580
x86 - ENU\x86\SQL_AS_OLEDB.msi
x64 - ENU\x64\SQL_AS_OLEDB.msi
If the drivers are not installed, the publishing step will fail.

2. Create or obtain the Tableau System Administrator credentials that will be used to
publish the sample Tableau workbooks. See “Add an Administrator Account” in the
Tableau Server 8.0 Administrator Guide. (This guide is available for downloading with the
Deltek Software Manager, along with the other Vision Performance Management
documentation.)
3. Publish sample workbooks to Tableau Server using the Deltek Vision Resource Kit tool
on the Vision Database server. See ”Publishing Tableau Sample Workbooks” on page 80
in this guide.
4. Import (or add) your Vision users to Tableau Server. See ”Add User Accounts to Tableau
Server” on page 86 in this guide.
5. If you use Local Authentication, add the IP addresses for all Vision Web/Application
Servers to the Tableau Server trust configuration. See “Trusted Authentication” in the
Tableau Server 8.0 Administrator Guide. (This guide is available for downloading with the
Deltek Software Manager, along with the other Vision Performance Management
documentation.)
Do the following on the server hosting Tableau Server:
a. Open an Administrative command prompt.
b. Change directory to your Tableau installation directory.
The default installation directory is C:\program files (x86)\Tableau\Tableau
Server\8.0\bin.

Installation and Configuration Guide for Performance
Management

78

Chapter 6: Performance Management Dashboards Installation and Configuration

c.

Stop the Tableau Server with the following command:
tabadmin stop

d. Add the Vision Web server IP addresses to the Tableau trust list with the
following command:
tabadmin set wgserver.trusted_hosts "<Trusted IP Addresses>"
For example, if you have three Vision Web/application servers with the IP
addresses 192.168.1.101, .102 and .103, enter the following:
tabadmin set wgserver.trusted_hosts "192.168.1.101, 192.168.1.102,
192.168.1.103"
Be sure you enter a space after each of the commas that separate the IP
addresses.
e. Commit the configuration with the following command:
tabadmin configure
f.

Restart Tableau Server with the following command:
tabadmin restart

6. Disable the vizqlserver.protect_sessions setting. That setting interferes with the ability to
show multiple Tableau workbooks on the Vision Dashboard.
Do the following on the server hosting Tableau Server:
a. Open an Administrative command prompt.
b. Change directory to your Tableau installation directory.
The default installation directory is C:\program files (x86)\Tableau\Tableau
Server\8.0\bin.
c.

Set vizqlserver.protect_sessions to false using the following sequence of
commands:
tabadmin stop
tabadmin set vizqlserver.protect_sessions false
tabadmin configure
tabadmin start

Set Up the Tableau Server Maintenance Process
With any software application, you want to ensure the following:


The application is always fresh (restarted periodically).



You have a good backup.



Logs are cleaned up.

Your Vision IIS application pool recycles at 12:15 a.m. every night by default, and the Analysis
Cubes are also refreshed every night at midnight by default. Use the procedure in this chapter to
do the same for your Tableau server.
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Maintain the Tableau Server
To refresh and back up the Tableau server and remove old log files, complete the
following steps:
1. Copy the batch script below into Windows Notepad.
2. Modify the backup locations (highlighted in the script below) as appropriate for your
server configuration.
3. If necessary, modify the file age parameter in the forfiles command as appropriate for
your backup strategy. If you do not change the current parameter value, the forfiles
command will look for and delete files older than 30 days.
4. Save the file as TableauCleanup.cmd (or something similar) in the Tableau bin directory
(c:\program files (x86)\Tableau\Tableau Server\8.0\bin).
5. Use Windows Task Scheduler to schedule the batch file to run at midnight or whenever
your Analysis Cubes are refreshed.
Refer to the following Microsoft Technet article if you are unfamiliar with Task
Scheduler: (http://technet.microsoft.com/en-us/library/cc721871.aspx).

Tableau Server Maintenance Script
@echo off
forfiles -p "e:\TableauBackup" -M *.* /D -30 /C "cmd /c del @path"
For /f "tokens=2-4 delims=/ " %%a in ('date /t') do (set mydate=%%c-%%a-%%b)
For /f "tokens=1-2 delims=/:" %%a in ("%TIME%") do (set mytime=%%a%%b)
::echo %mydate%_%mytime%
tabadmin stop
tabadmin ziplogs -l -n -f
ren logs.zip logs_%mydate%_%mytime%.zip
move /Y logs*.zip e:\TableauBackup\
tabadmin backup tableau_backup
ren tableau_backup.tsbak tableau_backup_%mydate%_%mytime%.tsbak
move /Y tableau_backup*.* e:\TableauBackup\
tabadmin cleanup
tabadmin start
tabadmin cleanup
The forfiles syntax may be different for your operating system. Test the script to make sure that
command is correct for your environment.

Publishing Tableau Sample Workbooks
After you configure the Vision Analysis Cubes and install and configure Tableau Server, the next
step is to publish the Deltek-provided sample workbooks to Tableau Server using the Vision
Resource Kit on the database server.

Prerequisite
Before publishing workbooks you must first install the Tableau Command Line Utility on the
Vision database server. The Vision database tier installation copies the Tableau Command Line
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Utility installer (TabCmdIntaller.exe) to <Vision Installation Directory>\Support\Utilities\ TabCmd.
Run this setup process on your Vision database server and accept the default installation
location. If, when you attempt to publish workbooks, you receive errors indicating that the
Resource Kit cannot find TabCmd, refer to “Chapter 7: Troubleshoot the Performance Dashboard
Deployment” on page 95.
By default the TabCmdPath registry setting points to the x64 installation location, which is
Program Files (x86). If your database server is 32-bit, edit that registry setting to point to
Program Files.

Publish the Sample Workbooks
The Publish process using the Resource Kit does the following:
1. Applies system labels to the sample workbooks.
2. Applies Analysis Cubes configurations to the sample workbooks (KPIs, and so on.)
3. Applies data source (Data Connection) information to the sample workbooks.
The preceding three steps result in modified workbook files, which are stored in the
\Vision\Workbooks\Processed_<Database>_<Language> folder.
4. Creates the database/language specific site on the server hosting Tableau Server.
5. Publishes the workbooks to Tableau Server.
6. Updates the Vision database with the Tableau Server and workbook configuration
information
To publish the sample workbooks, complete the following steps:
1. From your Vision database server, click Start » All Programs » Deltek Vision » Deltek
Vision Resource Kit.
If user account control (UAC) is enabled on your server (it is enabled by default), rightclick Deltek Vision Resource Kit and click Run as administrator on the shortcut
menu.

2. On the Deltek Vision Resource Kit dialog box, click the Database tab, and on the
Database Server Logon dialog box, select the Windows Integrated check box.
You must connect using Windows Integrated. If you do not select Windows
Integrated, and, instead, you use SQL Authentication, you will receive a message in
the Resource Kit during Step 1: Check Prerequisites that informs you that you must be
logged on to the Deltek Vision Resource Kit Database tab using Windows Integrated
Security.
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3. On the Database Server Logon dialog box, the server name displays in the Server field.
If you are running a non-default SQL Server instance, also enter the instance name in the
Server field (<server>\<instance>).
4. If you only have a single Vision database, it is automatically selected for you. Continue
with the next step.
If you have multiple Analysis Cubes databases, select the database and language being
used for that cube.
The Resource kit only remembers the database and language used for the last
Analysis Cube deployed.
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5. Click the Performance Management tab.

6. Verify that the non-selectable field information is accurate. This information is from the
Analysis Services tab:
Currently Selected Database — The Vision transaction database.
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Analysis Cube Database — The Analysis Cube database created during the Analysis
Services cube configuration.
Language — The language used for the Analysis Services database.
7. Enter the Tableau Server Configuration information.
Server Name — Enter the name of the server hosting Tableau Server.
The name should be entered as the user would to access the URL of the server hosting
Tableau Server directly (for example, Netbios server name or Fully Qualified DNS
name, such as vpm.company.com). Do not include the URL prefix (http:// or https://). If
you use SSL, the entry in Server Name must match the SSL certificate.

Authentication Type — Select Local (Tableau) or Active Directory. See “Tableau
Security Configuration” on page 73 for more information.
Port — The TCP/IP port that Tableau Server is configured to listen on. If Tableau Server
is installed using port 80, you can leave this field blank.
Use SSL — Select this check box if Tableau Server is configured for SSL.
Username — Username of a Tableau System Administrator account. If you use Active
Directory authentication, enter the username in this format: <Domain>\<Username>
Password — Password for the Tableau System Administrator.
Image Path — Path to the Deltek-provided images that are installed to the Tableau
server by the Deltek VPM installation. The field is populated with the default installation
location and should only need to be changed if you installed Deltek VPM to a drive/path
other than c:\Program Files (x86)\Deltek\Vision.
The above information is stored in the Vision database. Passwords are encrypted.

Save Settings — If you need to modify the saved Tableau Server configuration settings
without publishing workbooks, click this button to update the settings to include your
changes. For example, you may have used the server computer name rather than an
FQDN when publishing and while this will work for publishing it will not work for Internet
clients that need access to the dashboards where an FQDN to the server hosting
Tableau Server is required.
8. In Org Levels to Use, select the organization levels that will be used to filter the
workbooks you are publishing. You must select at least one level and can select up to
two. Organizations are specific to the Vision transaction database configuration. If you
are unsure which organization levels to use, contact the Vision Application Administrator.
9. Verify that the path to the template workbook in the Template Workbook Location field
is correct. The default location is C:\Program Files
(x86)\Deltek\Vision\Workbooks\Template where C:\Program Files (x86)\Deltek\Vision\ is
your Vision installation directory on the database server.
You can use the template workbook to build custom dashboard using the Tableau
Desktop tool. See “Apply KPIs to Template Workbook” on page 85 for instructions for
applying your Vision key performance indexes (KPIs) to the template workbook.
10. Leave Workbook Name Filter blank to publish all workbooks.
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If you do not want to publish all workbooks, you can enter a full workbook name or a
partial name with one or more wildcard characters (Org*, for example, to publish only
workbooks that start with Org).
11. When you have entered all information, click Publish Workbooks.
You do not use the Export Vision Users button as part of the publishing procedure.
See “Export Vision Users” on page 87 for information on the purpose of that button.

Apply KPIs to Template Workbook
Use the Apply KPIs to Template Workbook button on the Performance Management tab of the
Deltek Vision Resource Kit dialog box to apply your Vision Analysis Cubes configuration settings
(KPIs, and so on) to the template workbook file. Users who create custom workbooks use the
template workbook as part of that process.
To apply your Analysis Cubes configuration settings to the template workbook, complete
the following steps:
1. Verify that the path to the template workbook in the Template Workbook Location field
is correct. The default location is C:\Program Files
(x86)\Deltek\Vision\Workbooks\Template where C:\Program Files (x86)\Deltek\Vision\ is
your Vision installation directory on the database server.
2. Click Apply KPIs to Template Workbook
3. When this message displays, click Yes.

4. When this message displays, click OK.

The updated template workbook file will be locate in the following directory, C:\Program
Files (x86)\Deltek\Vision\Workbooks\Template\Processed.
5. Send this updated template workbook to the users responsible for creating custom
workbooks.
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You can update the template workbook as described above without performing any of the steps
in the workbook publishing procedure.

Add User Accounts to Tableau Server
You can add users to Tableau Server using an export-import process, or you can set up users
manually in Tableau Server one at a time. You must be either a System Admin or Site Admin to
add users to Tableau Server.

Add Domain Users
If you use Active Directory security, you must add your domain users to Tableau Server as
described above so those users can access the Vision Performance Management dashboards in
Vision. Once the users have been added as Tableau users, they can access the dashboards
either from Vision or directly through Tableau Server.

Add Local (Tableau) Users
If you have configured Tableau Server to use Local Authentication, all access to dashboard
content occurs under the context of a single Tableau security account. That account is configured
as a System Administrator in Tableau Server and is the account used to publish the workbooks
using the Resource Kit. This configuration makes it impractical, from a security perspective, to
provide your users with access to Tableau Server outside of Vision because you would have to
provide all of your users with the username and password of this System Administrator account.
The ability to map your Vision security user accounts to Local (Tableau) security user accounts
(with the same username) is not currently supported.
Though the implementation for Local (Tableau) authentication does not provide a direct user-touser mapping, you can still create Local (Tableau) security users using your users’ Vision security
usernames, which can then be used for accessing Tableau Server from outside of Vision. Refer
to “Local Authentication” on page 74 for information on limitations associated with this
configuration.
When using Local (Tableau) authentication, a password is required. The password column in the
export file for all users will default to “password”. After they log in to Tableau Server, users will
need to change their Tableau Server password under User Preferences or you can modify the
export file and set a password for yours users:

Installation and Configuration Guide for Performance
Management

86

Chapter 6: Performance Management Dashboards Installation and Configuration

Export Vision Users
The Deltek Vision Resource Kit dialog box includes an Export Vision Users button on the
Performance Management tab that creates a .csv export file containing all of your Vision users.
The users exported are filtered in the following ways:


If you use Local (Tableau) authentication — The export only includes "non-disabled",
Vision Security (non-Active Directory) logins.



If you use Active Directory authentication – The export only includes "non-disabled",
Active Directory logins for which the domain has been specified in Vision security
configuration.
All users are exported that meet the criteria referenced above. In multiple database/cube,
multiple language implementations, you may need to break this export up into site level users
and import at the site level in Tableau rather than the server level. (At the server level, users
have access to all sites.) More information on this is provided below.

Export Process
The export process is not dependent on any other functionality on the Performance Management
tab and can be run at any time. The only requirement is that you select the correct option in
Authentication Type (Local (Tableau) or Active Directory) so the export process exports the
correct information.
To export Vision users, complete the following steps:
1. Display the Vision Resource Kit, click the Database tab, and click the Performance
Management subtab.
2. In Authentication Type, select your authentication type.
3. Click Export Vision Users.
4. When this message displays, click Yes.

5. When prompted, specify the location in which to save the export file. The default location
is the Vision\Temp folder, and the default filename is VisionUsers.csv.
When the process is finished, a confirmation message displays.
CSV File Format
The format of the .csv file exported using the Resource Kit is as follows:
Username,Password,Full Name,License Level,Administrator,Publisher
Example Active Directory export file:
INETTEST2K8N\VPMUser1,,”VPM User 1”,Interactor,None,No
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Example Local (Tableau) export file:
ADMIN,password,"William Apple",Interactor,None,No
JAMESB,password,"James Bartlett",Interactor,None,No
The table below describes the data in the export file in more detail:
Data Item

Description

Username

This field contains the user’s login name.
If you use Active Directory, the format is <Domain>\<Username>.
If you use Local (Tableau) authentication, the format is <username>.

Password

This field contains the user’s login password, if applicable.
If you use Active Directory, this field is blank.
If you use Local (Tableau) authentication, this field contains password, the
default password.
Users can change their passwords on the User Preferences page after they
successfully log in to Tableau Server.

Full Name

This field contains the full name of the user, for display purposes.

License Level

This field contains the user’s Tableau license level that controls the user’s level
of access to the workbooks: Interactor, Viewer, or None.
The default value is Interactor.

Administrator

This field contains the user’s Tableau Server administrative level: System,
Site, or None.
The default value is None.

Publisher

This field indicates if the user has the access necessary to publish workbooks:
Yes or No.
The default value is No.

You can modify the values in the License Level, Administrator, and Publisher fields
before performing the import if you have specific users who require additional rights.
You can also modify rights in Tableau after the import.
Refer to the Tableau Online help for additional information:
http://onlinehelp.tableausoftware.com/v8.0/server/en-us/help.htm#csvguidelines.htm
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Import Users into Tableau Server
About Tableau Sites
The Default site is the site created by the Tableau Server configuration. Vision does not use the
Default site. Publishing Tableau workbooks with the Resource Kit creates a site name in the
format <Database name>_<language> (for example, Vision_en-US for a database named
Vision using English United States as the language). A new site conforming to this naming
convention is created each time workbooks are published for a new database/language
combination.
Performing the User Import
You can perform the import at the Default site level and then modify the site membership for a
single user or groups of users after the import using Site Membership, or you can import at the
site level directly. If the account performing the import is only a site administrator in Tableau, then
you can only import users to that site.
To perform the import, complete the following steps:
1. Open a browser and enter the URL for Tableau Server.
2. Log in to Tableau Server, select your site, and click OK.

If you use Active Directory authentication with Enable Automatic Login
enabled, you are immediately prompted to choose the Tableau site to log in to.
If you use Local (Tableau) authentication, a login prompt displays initially.
3. Click the Admin button on the navigation menu on the left side of the page.
4. Select either the All Users or Site Users menu.

These menu choices function the same except that one displays all users and
the other displays only users associated with that particular site. If you are only
a Site Administrator, you have only a Users menu available.
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5. Click the Import option.

6. Click Browse and select the VisionUsers.csv file.
7. Click Check File to identify any potential errors. Fix any errors before proceeding.

8. Click Import Users.
The following dialog box displays to provide information on the users imported:

9. Click Exit when the process is completed.
After the Import
As indicated previously, you may have several Vision Analysis Cubes, each with its own Tableau
site. If you import all users at the Default site of Tableau Server, follow the steps below to modify
the site membership for your users.
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If the user is not added to the site membership for the site that maps to the Analysis Cube that
they are accessing, they cannot access the dashboards. For example, if you add all of your
users to the English site (en-US) and a user logs into Vision as French Canadian (fr-CA), that
user will not be able to access the dashboards until you add them to the <Database name>_<frCA> site in Tableau Server.

To modify the site membership, license level, or administrator rights for one or more users, select
the users and select the appropriate menu choices.

To modify the publishing rights, use the Site Users menu.

Ongoing User Maintenance
There is no “synchronization” functionality between users in Vision and Tableau Server. As new
users are added to, removed from, or disabled in Vision they will need to be added to, removed
from, or disabled manually in Tableau Server.

Test your Tableau Server Installation/Configuration with Vision
When you have completed the Tableau Server configuration, user creation, and workbook
publication, test access to the dashboards in Vision to validate the configuration.
To test your configuration, complete the following steps:
1. Log in to Vision and access the Vision Dashboard.
2. On the Vision Dashboard toolbar, click Configure and Add Web Dashpart. The Add
Web Dashpart dialog box displays.
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3. In Web Part Name, enter a name for the dashpart.
4. In Address Type, select Performance Management Dashboard.
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5. In Dashboard, select one of the listed performance dashboards.

6. Click Save to add the dashboard to your Vision Dashboard as a dashpart.
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Access Tableau from Outside of Vision
You can access Vision Performance Management dashboards from within Vision either as Web
dashparts on the Vision Dashboard or through Vision Reporting. You can also access the same
dashboards directly from Tableau Server using a browser.

Tableau Server Configured for SSL
If Vision is configured to use SSL, Tableau Server must be configured for SSL also. If users enter
http:// as the URL prefix for Tableau Server, Tableau automatically redirects them to https://.
However, if users will access Tableau Server from outside your corporate network, you must also
make the necessary firewall modification to allow access to Tableau Server from the internet.

Access Tableau Desktop from the Internet
If users need to access Tableau Desktop from the internet to create custom workbooks, with the
Analysis Cubes behind a firewall, you must configure the OLAP data pump as defined in “Chapter
5: Configure Analysis Cubes for Internet Accessibility” on page 54. Those Tableau Desktop user
will use the same URL that is used in Excel in that chapter.

Note on Local Authentication/Vision Security
As noted earlier in this guide, if you use Vision Security and Tableau Local authentication, the
behavior of the dashboards is different when accessed outside of Vision. Refer to “Local
Authentication” on page 74 for more information.
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Chapter 7: Troubleshoot the Performance
Dashboard Deployment
Problem:
When you attempt to publish workbooks using the Resource Kit, you receive the following errors:
3/20/2013 (12:19 PM) - <user> - Error publishing workbook Executive Sample - Accounts
Receivable and Promotional Costs.twb. *** The drivers necessary to connect to the database
server 'ASHAPP96VS' are not properly installed on Tableau Server. Visit
http://www.tableausoftware.com/drivers to download driver setup files.
Database error 0x80040154: Class not registered
Unable to connect to the server. Check that the server is running and that you have access
privileges to the requested database. Operation Canceled.
Solution:
The Analysis Services OLE DB drivers are not installed on the Tableau server. Install the correct
drivers as indicated in “Final Tableau Server Configuration” on page 78 and restart Tableau
Server.
Problem:
When you attempt to publish workbooks using the Resource Kit, you receive the following error:

Solution:
Make sure that the TabCmd utility is installed and that the TabCmdPath registry value is correct.
The TabCmdPath registry location is HKLM\Software\Wow6432Node\Deltek\Vision for 64-bit
database servers and HKLM\Software\Deltek\Vision for 32-bit database servers.
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TabCmdInstaller.exe is installed with the Deltek Vision database tier installation to the following
location:
C:\Program Files (x86)\Deltek\Vision\Support\utilities\TabCmd
By default the TabCmdPath registry setting points to the x64 installation location, which is
Program Files (x86). If your database server is 32-bit, edit that registry setting to point to
Program Files.

The default location of TabCmdInstaller.exe on the Tableau server is:
C:\Program Files (x86)\Tableau\Tableau Server\8.0\extras
(If you have a 32-bit server, the location is C:\Program Files\ Tableau\Tableau Server\8.0\extras.)
Problem:
You use Active Directory authentication, and the Tableau Logon prompt displays when you
attempt to view a Performance Management dashboard.

Solution:
Tableau Server is configured for Active Directory authentication, and Enable Automatic Login is
not selected in the Tableau Server configuration. Run the Tableau Server configuration utility to
enable automatic login.
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Problem:
You use Local (Tableau) authentication and receive the “Deltek Vision cannot generate trusted
ticket” error.

Solution:
The Vision Web/application server is not in the Tableau Server trust list. Add the Web/application
server IP address to the Tableau Server trust configuration, as indicated in “Final Tableau Server
Configuration” on page 78, and restart Tableau Server.
Problem:
You receive an error publishing workbooks when internal CA-issued SSL certificate is used.

Solution:
On the Performance Management tab of the Vision Resource Kit, clear the Validate SSL
Certificate check box so that TabCmd does not validate the certificate during the publish
process.
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Problem:
Vision is accessed using SSL (https), the Tableau Server is not yet configured for SSL, and the
following message displays:

Solution:
If Vision can be accessed through SSL, even if only for a small subset of users, Tableau Server
must be configured for SSL, or those users cannot access the dashboards.
Problem:
You may receive an authentication prompt from your internet browser when accessing the
dashboards.
Solution:
If using SSL and Active Directory, browser security settings must be set to Automatic Logon
with current username and password.
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Problem:
You receive various errors when you publish workbooks (one example below).

Solution:
Review the Resource Kit Log file (<Vision installation folder>\Logs\DeltekVisionResourceKit.log)
for error details. Below are suggestions for some specific error conditions:


*** Internal Error Tableau Server encountered an unknown error. Operation
Canceled
Attempt to load the processed workbook in Tableau Desktop. If there are issues with
KPIs, dimensions, or measure, Tableau Desktop identifies them with an error, as shown
below:



*** Internal Error Tableau Server encountered an unknown error. Operation
Canceled
Another reason for this error could be caused by low memory conditions on the Tableau
server during the publish process. If opening the workbook in the desktop tool does not
yield any errors and memory utilization on the Tableau server exceeds 90%, try restarting
the Tableau Server process and attempt the publishing again.



*** execution expired
This error indicates that the gateway timeout on the Tableau server needs to be
increased. To increase the timeout limit, navigate to the Tableau bin directory in an
Administrative command prompt on the Tableau server, and run the following commands:
tabadmin stop
tabadmin set gateway.timeout 3600
tabadmin set vizqlserver.querylimit 3600
tabadmin configure
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tabadmin start
In addition, you can try publishing the failed workbooks manually using the TabCmd command
line utility.
To publish a workbook using the TabCmd command line utility, complete the following
steps:
1. Open an Administrative command prompt (Run As Administrator).
2. Change to the folder in which the TabCmd command line utility is installed. (The default
location is C:\Program Files (x86)\Tableau\Tableau Server\8.0\extras\Command Line
Utility.)
3. Use the Resource Kit Log file to identify a workbook that failed to be published.
4. Run the following command:
Tabcmd publish –s <Tableau server URL> -t <Tableau Site> -u <Tableau Account> -p
<Tableau Account Password> <Path and name of processed workbook> -n <Name of
workbook>
Tableau Server URL – The URL of the Tableau server.
Tableau Site – Name of the Tableau site: <Vision database name>_<language>.
Tableau Account – Tableau user account with publish rights. If you use Active
Directory authentication, the account name should be in the <domain>\<user>
format.
Tableau Account Password – Password of the Tableau user account.
Path and name of processed workbook – This is in your Vision installation folder
on the database server. The format is <Vision installation
folder>\Workbooks\Processed_<Vision database name>_<language>\<name of
the workbook .twb file>.
Name of Workbook – The name of the workbook .twb file.
For example, for the ASHAPP99VS server and a Vision database named VisionDemo70
in English (United States), the command would be similar to the following:
tabcmd publish -s http://ashapp99vs -t VisionDemo70_en-US -u "Tableau_Admin" -p
Password1 “c:\program files
(x86)\Deltek\Vision\Workbooks\Processed_VisionDemo70_en-US\Executive Sample
- Revenue Analysis.twb" -n "Executive Sample - Revenue Analysis.twb
The result of the command would look like this:
===== Creating new session
=====

Server: http://ashapp99vs/

=====

Username: Tableau_Admin

=====

Site:

VisionDemo70_en-US

===== Connecting to server...
===== Logging in...
===== Login Succeeded.
===== Connecting to server...
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===== Publishing c:\program files
x86)\Deltek\Vision\Workbooks\\Processed_VisionDemo70_en-US\Executive Sample
- Revenue Analysis.twb to server. This could take several minutes...
===== File successfully published to the Tableau Server, at the following location:
===== http://ashapp99vs/t/VisionDemo70_en-US/workbooks/ExecutiveSampleRevenueAnalysis_twb
5. Manually run an insert statement for the workbook in the FW_Workbook table of the
Vision database.
For example:
INSERT INTO dbo.FW_Workbook (Workbook, ViewName, UrlName, Site) VALUES
(‘Executive Sample - Revenue Analysis’, N'Executive Sample - Revenue Analysis',
'ExecutiveSample-RevenueAnalysis ', 'VisionDemo70_en-US')
Note that spaces are removed for the UrlName parameter.
Problem:
If you use Active Directory with Tableau Server and you need to add user accounts from a trusted
domain, the first time you attempt to add the user using the standard domain nickname (for
example DOMAIN\User) Tableau server will not be able to recognize the domain nickname. In
this situation, you must enter the domain using the fully qualified domain name (for example
DOMAIN.COMPANY.COM\User). In addition, because of a defect in Tableau Server, it assumes
that the first word before the period in the fully qualified domain name is the domain nickname
(DOMAIN for the example above). This may or may not be correct for your organization. If it is not
correct, users cannot to authenticate to Tableau Server until you correct the domain nickname.
Solution:
To resolve this problem, complete the following steps:
1. Log on to Tableau Server as a System Administrator.
2. Select the Admin menu in the upper left.
3. Select All Users from the left side Navigation menu.
4. Select the user that was created using the fully qualified domain name (with the incorrect
domain nickname) by checking the box to the left of the name.
5. Click the Domain link above and edit the fully qualified and domain nicknames as
appropriate for your organization.
Problem:
When you attempt to publish workbooks, you receive a message indicating that no workbooks
were published. The Resource Kit log indicates the following error:
6/13/2013 (11:38 AM) - <User> - ERROR PUBLISHING WORKBOOK Business
Development Manager Sample - Opportunity Wins and Projections.twb:
*** The server is not licensed to connect to 'Microsoft Analysis Services' data sources.
Operation Canceled.
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Solution:
This occurs when the Deltek-provided Tableau license keys were added to the Tableau Server
configuration, but the Tableau services were not restarted. Restart the Tableau services.
Problem:
When you attempt to load a VPM dashboard in Vision, this message displays:

Solution:
This occurs when the vizqlserver.protect_sessions setting has not been disabled. For instructions
for disabling this setting, see the last step under “Final Tableau Server Configuration” on page 79.
Problem:
When you attempted to load a VPM dashboard in Vision, you received the following error:

Solution:
This occurs when the Tableau server process has not been restarted since the last Analysis
Cubes refresh. Refer to “Set Up the Tableau Server Maintenance Process” on page 79 for the
steps to ensure that your Tableau server is backed up and restarted each night.
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Appendix A: Configure Vision Analysis Cubes for
a SQL Server Clustered Environment
You can configure Vision Analysis Cubes to operate in a SQL Server clustered environment using
the Vision Resource Kit.

Deploy Vision Analysis Cubes to a SQL Cluster
This process requires that both nodes in the cluster be rebooted. Deltek recommends that you
schedule this process during an appropriate maintenance window, ideally after working hours.
To deploy Vision Analysis Cubes to a SQL cluster, complete the following steps:
1. Install and configure a working SQL 2008/2008 R2 cluster.
2. Perform a Vision database tier-only installation on both nodes to the same installation
path on the local server. Do not install Vision to the shared cluster storage.
3. Reboot both nodes. This is necessary to ensure that the environment variables exist and
are active on both nodes in case of fail-over.
4. Build the Vision data cubes on Node1 of the cluster using the Vision Resource Kit:
a. Run the Resource Kit using Run as Administrator. See “Open the Vision Resource
Kit” on page 17 for specific instructions on Run as Administrator.
b. Click the Resource Kit Database tab, and connect to your server using the cluster
virtual name (not the name of the cluster node you are running it on).

c.

Click the Analysis Services tab (a sub-tab of the Database tab).

d. On the Analysis Services tab, click the Step 1: Check Prerequisites button to
confirm that all the prerequisites are installed.
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Detailed instructions and screen shots for each of the steps on the Analysis
Services tab can be found starting with the “Check Prerequisites” section on page
19.

e. On the Analysis Services tab, click the Step 2: Setup button to create the data
warehouse and Analysis Services database.
f.

Grant the SQL Server Agent services account database owner (db_owner) rights to
the data warehouse database that was created as part of running Resource Kit Step
2: Setup. The data warehouse will be the name of your Vision database with DW
appended to it.

g. On the Resource Kit Analysis Services tab, click the Step 3: Apply System Labels
to Cubes button to apply your custom field labels to the data warehouse.
h. On the Analysis Services tab, click the Step 5: Populate DW and Vision Cubes
button to populate the data warehouse and the data cubes. This step will fail if the
service account does not have rights to the data warehouse as assigned in step f
above.
i.

If you purchased and activated the Vision Performance Management module,
complete the following steps:
1) In Vision, enter and save the settings on the Analysis Cubes Configuration
form in Configuration » General » Analysis Cubes.
2) In the Vision Resource Kit, open the Analysis Services tab (a sub-tab on the
Database tab), and click the Step 4: Apply Cubes Configurations button to
apply the settings in Vision Analysis Cubes Configuration to the data
warehouse and data cubes.
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3) On the Analysis Services tab, click the Step 5: Populate DW and Vision
Cubes button to populate the data warehouse and the data cubes.
5. Use Notepad to open the \Vision\Analysis\ETL_2K8\Jobs\<database
name>\VisionETL_Config.dtsconfig file on the Vision database tier server. Ensure that
the SQL cluster virtual name is used as the data source. See the file example below. If
you connected to the SQL virtual name in Step 4b, it will be specified correctly.
6. Copy the \Vision\Analysis\ETL_2K8\Jobs folder to the \Vision\Analysis\ETL_2K8
folder on the other nodes in the cluster so that the refresh job will still function in the
event of a fail-over. These folders were created when you performed the Resource Kit
Step 5: Populate DW and Vision Cubes.
7. Perform a manual fail-over of the cluster, and run the SQL Agent Refresh Job to ensure
that everything is working properly.
Example of the contents of the VisionETL_Config.dtsconfig file
The following example shows the contents of a VisionETL_Config.dtsconfig file (color-coded here
for easier identification).


Data Source=<the Virtual name of the SQL Cluster>



First instance of Initial Catalog=<Vision database name>



Second instance of Initial Catalog=<Vision data warehouse name>



Third instance of Initial Catalog=<Vision analysis cube name>

<?xml version="1.0"?>
<DTSConfiguration>
<DTSConfigurationHeading>
<DTSConfigurationFileInfo GeneratedBy="ADSDELTEKCOM\sonnyrai"
GeneratedDate="7/27/2007 4:29:36 PM" />
</DTSConfigurationHeading>
<Configuration ConfiguredType="Property"
Path="\Package.Connections[Vision].Properties[ConnectionString]" ValueType="String">
<ConfiguredValue> Data Source=SQLCLUSTER\INST1; Initial
Catalog=VisionDemo70;Provider=SQLNCLI10;Integrated Security=SSPI;Auto
Translate=False;</ConfiguredValue>
</Configuration>
<Configuration ConfiguredType="Property"
Path="\Package.Connections[VisionDW].Properties[ConnectionString]" ValueType="String">
<ConfiguredValue> Data Source=SQLCLUSTER\INST1; Initial
Catalog=VisionDemo70DW;Provider=SQLNCLI10;Integrated Security=SSPI;Auto
Translate=False;</ConfiguredValue>
</Configuration>
<Configuration ConfiguredType="Property"
Path="\Package.Connections[VisionCubes].Properties[ConnectionString]" ValueType="String">
<ConfiguredValue> Data Source=SQLCLUSTER\INST1; Initial Catalog=Deltek Vision
Analysis – VisionDemo70;Provider=MSOLAP.4;Integrated Security=SSPI;Impersonation
Level=Impersonate;</ConfiguredValue>
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</Configuration>
</DTSConfiguration>

Troubleshooting
“Chapter 3: Troubleshoot Analysis Cubes Deployments” on page 48 outlines the steps to
troubleshoot failures in the SQL Agent Refresh Job by creating a SQL Agent output file. These
steps also apply in a clustered environment, with the addition of the following for a clustered
environment:


The SQL Agent job output files can be the output files to the SQL Server cluster drives
only.



The SQL Agent service account needs modify rights to the chosen directory for output
files during the SQL Agent job execution.

To ensure that this works properly, create a folder on one of the shared cluster drives. Be sure
that the SQL Agent service account has modify rights to that folder as shown in the following
screen shot:
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The following error displays in the SQL Agent Job output file if the SQL Agent service account
does not have rights to the data warehouse database as specified in step 4f above.
Error: 2012-07-30 16:47:55.88
Code: 0xC1060000
Source: Analysis Services Processing Task Analysis Services Execute DDL Task
Description: OLE DB error: OLE DB or ODBC error: Login failed for user
'INETTEST2K3N\sqlclustersvc'.; 28000.
End Error
Error: 2012-07-30 16:47:55.88
Code: 0xC1120064
Source: Analysis Services Processing Task Analysis Services Execute DDL Task
Description: Errors in the high-level relational engine. A connection could not be made
to the data source with the DataSourceID of 'VisionDW', Name of 'VisionDW'.
End Error
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